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Introduction
Your EPSON Stylus® COLOR 740 printer is the ideal output device
for business graphics, layout proofs, digital photography, or any
project you create on your computer. With resolutions up to 1440 by
720 dpi and EPSON’s unique variable micro droplet technology,
you get amazingly realistic photographic images, vivid color
graphics, and razor-sharp black text.
The printer software for Microsoft® Windows® and Macintosh®
provides advanced color management with adjustable levels of
brightness, contrast, sharpness, and other settings. Support for
ColorSync™ 2.01 and two Windows color matching methods gives
you even more precise color control.
EPSON’s specially formulated ink cartridges and wide variety of ink
jet papers offer the most flexibility for getting the results you want.
With standard parallel, serial, and high-speed USB (Universal
Serial Bus) ports, setting up your printer is fast and easy.
This chapter gives you general information about your printer in
these sections:
◗

Windows System Requirements

◗

Macintosh System Requirements

◗

Printer Parts
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◗

How To Use Your Manuals

◗

ENERGY STAR Compliance

◗

Year 2000 Ready

◗

Important Safety Instructions

Windows System Requirements
To use your printer and its software with a PC, your system should
have:

Introduction

◗

An IBM® compatible PC with at least a 386/25 MHz (for
Windows 3.1x), 486/25 MHz (for Windows 95 or Windows
NT® 4.0), or 486/66 MHz (for Windows 98) processor
(Pentium® processor recommended)

◗

DOS, Microsoft Windows 3.1x, Windows 95, Windows 98, or
Windows NT 4.0

◗

At least 16MB of RAM (32MB for Windows 3.1, 95, or 98 or
64MB for Windows NT 4.0 recommended)

◗

At least 50MB of free hard disk space for storing images
(100MB recommended)

◗

VGA, Super VGA, or better display adapter and monitor

◗

Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software
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◗

Caution:
Using an improperly
shielded USB cable—
especially a cable
more than 6.5 ft.
(2 meters) long—may
cause the printer to
malfunction.

Introduction

For parallel connection, a high-speed, bidirectional, IEEE-1284
compliant parallel cable (6 to 10 feet long). The cable must
have a D-SUB, 25-pin, male connector for your computer and a
36-pin, Centronics® compatible connector for the printer.
For USB connection to a computer with Windows 98 and a
Windows 98 compliant USB port, a shielded USB “AB”
interface cable, from Series A (computer) to Series B (printer)
up to 6.5 ft. (2 meters) long
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Macintosh System Requirements
To use your printer and its software with a Macintosh, your system
should have:
Caution:
If your iMac is running
OS 8.1, you must
download and install
the iMac Update 1.0
from Apple at
http://swupdates.info.
apple.com before yo
install the EPSON
USB printer software.
Contact Apple
Computer if you have
problems installing
this update.
If you iMac is running
OS 8.5, you don’t
need to download
and install the iMac
Update 1.0; your
system includes full
support for the
EPSON USB printer
software.

Introduction

◗

One of the following Macintosh models:
LC475, LC575, LC630
Quadra series
Centris series
PowerBook® series (190, 520, 540, 550 or later)
PowerBook Duo 280, 2300c/100
Performa® 475, 575, 588, 630, 5210 or later
Power Macintosh® series
iMac™ Series (USB connection only
Power Macintosh G3 (USB connection only)

◗

For serial connection: System 7.1 or later (7.6 or later
recommended); some application software on the EPSON
CD-ROM may require System 7.52 or later
For USB connection: iMac or Power Macintosh G3 with Ssytem
8.1 or later

◗

At least 16MB of RAM (20MB or more recommended)

◗

At least 50MB of free hard disk space for storing images
(100MB recommended)

◗

13-inch RGB display or better
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Caution:
Using an improperly
shielded USB cable—
especially a cable
more than 6.5 ft.
(2 meters) long—may
cause the printer to
malfunction.
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◗

Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software

◗

For serial connection, an ImageWriter® II serial cable or
equivalent (8-pin mini DIN male/male, Belkin F2V024
recommended)
For USB connection to an iMac or Power Macintosh G3, a
shielded USB “AB” interface cable, from Series A (computer) to
Series B (printer) up to 6.5 ft. (2 meters) long
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Printer Parts
paper support
edge
guides

printer cover

output tray

sheet feeder

output tray extensions

paper thickness
lever

ink cartridge holders

Introduction

control panel
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How To Use Your Manuals
To set up your printer and install the printer software, see the Start
Here card. This manual contains the following information:
Basic Printing covers the basics of printing with Windows or
Macintosh.
Advanced Printing tells you how to print using custom settings for
print quality, color management, and distinctive layouts.
Printing on Special Media gives guidelines for selecting the right
paper or other media for your print job and instructions for loading it
in your printer.
Managing Print Jobs explains how to control print jobs and check
printer status while you’re printing.
Maintenance and Transportation gives instructions for replacing ink
cartridges, cleaning and aligning the print head, and cleaning and
transporting the printer.
Troubleshooting provides solutions for any problems you may have
with your printer or software.
Specifications provides the technical details on your printer, ink
cartridges, and EPSON papers.
To go right to the section you need, see the Index.

Introduction
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Warnings, Cautions, Notes, and Tips
You’ll find this information throughout your manual:
Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this
product meets the ENERGY STAR guidelines for energy efficiency.
The EPA ENERGY STAR Office Equipment program is a voluntary
partnership with the computer and office equipment industry to
promote the introduction of energy-efficient personal computers,
monitors, printers, fax machines, and copiers in an effort to reduce
air pollution caused by power generation.
Introduction
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Year 2000 Ready
Your EPSON printer is Year 2000 Ready. However, be sure
the other parts of your computer system are also ready for the
year 2000.

Important Safety Instructions
Before using your printer, read the following safety instructions to
make sure you use the printer safely and effectively:
Caution:
Always turn the
printer off using the
P power button.
Don’t switch off the
electrical outlet or
power strip, or unplug
the printer until the
P power light is off.

Introduction

◗

Turn off and unplug the printer before cleaning. Clean with a
damp cloth only. Do not spill liquid on the printer.

◗

Do not place the printer on an unstable surface or near a
radiator or heating vent.

◗

Do not block or cover the openings in the printer’s cabinet or
insert objects through the slots.

◗

Use only the type of power source indicated on the printer’s
label.

◗

Connect all equipment to properly grounded power outlets.
Avoid using outlets on the same circuit as photocopiers or air
control systems that regularly switch on and off.
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◗

Place the printer near a wall outlet where the plug can be easily
unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche
peut être débranchée facilement.
◗

Do not let the power cord become damaged or frayed.

◗

If you use an extension cord with the printer, make sure the
total ampere rating of the devices plugged into the extension
cord does not exceed the cord’s ampere rating. Also, make
sure the total ampere rating of all devices plugged into the wall
outlet does not exceed the wall outlet’s ampere rating.

◗

Except as specifically explained in this manual, do not attempt
to service the printer yourself.

◗

Unplug the printer and refer servicing to qualified service
personnel under the following conditions:
If the power cord or plug is damaged; if liquid has entered the
printer; if the printer has been dropped or the cabinet damaged;
if the printer does not operate normally or exhibits a distinct
change in performance. Adjust only those controls that are
covered by the operating instructions.
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◗

Do not put your hand inside the printer or touch the cartridge
during printing.

◗

Under normal circumstances, ink will not come out of the
cartridge. If it does get on your skin, wash it off with soap and
water. If it gets in your eyes, flush them immediately with water.
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◗

Keep ink cartridges out of the reach of children.

◗

Do not dismantle the ink cartridges or try to refill them. This
could result in damage to the print head.

◗

Once you install an ink cartridge, do not open the clamp or
remove the cartridge except to replace it with a new one. The
cartridge may become unusable otherwise.

◗

Install the ink cartridge immediately after you remove it from its
foil package. Leaving the cartridge unpacked for a long time
before use may result in reduced print quality.

◗

Do not use an ink cartridge beyond the date printed on the
cartridge package. For best results, use up the ink cartridges
within six months of installing them.

◗

Do not shake an ink cartridge; this can cause leakage.

◗

Always turn the printer off using the Ppower button. When you
press this button, the Ppower light flashes briefly then goes
out. Do not unplug the printer or turn off the power to the outlet
until the Ppower light is off.

◗

Before transporting the printer, make sure the print head is
capped in the far right position and the ink cartridges are in
place.
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Basic Printing
It’s easy to print all your color and monochrome documents with
your EPSON Stylus COLOR 740. First set up your printer and
install the software, following the instructions in the Start Here card.
Read this chapter to find out about:
Note:
For instructions on
printing with DOS,
see DOS Support.

◗

Printing from Windows

◗

Printing from a Macintosh

Printing from Windows
This section tells you about:
◗

Setting Printer Options from Windows Applications

◗

Setting Default Printer Options

◗

Checking Printer Status
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Setting Printer Options from Windows Applications
This section describes the settings you’ll need to check for all your
everyday printouts. See Advanced Printing for information about
advanced settings for special print jobs.

Note:
You can also set
printer options by
clicking Print Setup in
the File menu, then
clicking the Printer,
Setup, Properties, or
Options button.
However, in most
applications you’ll
then have to select
the Print option from
the File menu to print
using your changes.

1

Open a Windows application and select a file you want to print.

2

Open the File menu and click Print. You see the Print dialog
box for your application.

Click Properties

3

Basic Printing

Make sure your EPSON Stylus COLOR 740 printer is selected,
and then click the Properties, Printer, Setup, or Options
button. (You may have to click a sequence of buttons in
different dialog boxes.)
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You then see the printer settings dialog box:
Click to select
your media type
Click to select
Automatic mode

Use the
Quality/Speed
slider to select
your print
resolution

Click for more
information

4

To print at the highest
resolution (1440 dpi),
you need to use plain
paper, Photo Paper,
or one of the Photo
Quality media. For the
best printing at any
resolution, always use
EPSON media.

Basic Printing

Click the Main tab if necessary. Then choose the Media Type
you want to print on from the following list:
◗

Plain paper

◗

360 dpi Ink Jet Paper

◗

Photo Quality Ink Jet Paper

◗

Photo Paper

◗

Photo Quality Glossy Film

◗

Ink Jet Transparencies
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The type of paper you choose determines the print quality
(resolution) you can use. It’s very important to select the correct
setting for your paper. If you’re not sure which to choose, see
Selecting Special Media.

Note:
The Quality/Speed
slider is not available
for certain media
types.

5

Choose Color or Black ink.

6

Now make sure the Mode option is set to Automatic. This is
the easiest way to get good printing results for all kinds of
documents, on all types of paper.

7

Set the slider to Quality or Speed. This lets you choose
between the fastest printing or the highest resolution for the
media you’re using.
To select 1440 dpi on plain paper or any other available
resolution for your media, you need to access the Advanced
dialog box; see Customizing Print Quality and Special Effects
for instructions.

8

Click the Paper tab and choose your paper size, number of
copies, orientation, and printable area settings. See Selecting
Paper Options in Windows for instructions.

9

Click the Layout tab (not available with Windows 3.1) and
check the reduce/enlarge, page layout, and watermark
settings. See Choosing Print Layout Options in Windows for
details.

10 Click OK when you’re finished checking your settings. The
dialog box closes. Click OK until you see the Print dialog box.
11 In the Print dialog box, click OK or Print.
Basic Printing
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While your document is printing, a window appears showing
the printer status and the progress of your print job. See
Checking Printer Status for more information.

Setting Default Printer Options
When you change printer settings through your software
application, the settings apply only to the application you’re using.
To adjust the default settings for all your Windows applications,
access the printer settings through the Printers utility or Control
Panel (Windows 3.1). Close all your applications before you start. If
you don’t, you may have to close and reopen them to use the new
default settings.
Note:
You can access the
default Windows NT
printer software
settings only if you
have the appropriate
network access
privileges, such as
Administrator.

Basic Printing

Setting Default Options in Windows 95, Windows 98, or
Windows NT
1

Click Start, point to Settings, and select Printers.

2

Right-click the EPSON Stylus COLOR 740 icon.

3

Select Properties or Document Defaults (Windows NT), then
click the Main tab. You see the printer settings dialog box
shown under Setting Printer Options from Windows
Applications with some additional tabs at the top.
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Setting Default Options in Windows 3.1
1

Double-click the Control Panel icon in the Main group.

2

Double-click the Printers icon.

3

Select EPSON Stylus COLOR 740 from the list of printers and
click Setup. You see the printer settings dialog box shown
under Setting Printer Options from Windows Applications.

Checking Printer Status
While your document is printing, your printer software reports how
the job is doing. See the following for your operating system:

Basic Printing

◗

Windows 95, Windows 98, or Windows NT 4.0

◗

Windows 3.1
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Windows 95, Windows 98, or Windows NT 4.0
After you send a print job in Windows 95, 98, or NT, the Progress
Meter window appears on your screen:
Click to cancel
Click to pause
This
information
appears only
if you installed
Status
Monitor 2

Click to restart
Click to view the Status
Monitor 2 Printer Status
window

The Progress Meter shows the progress of your print job and the
status of your printer. You can use the buttons to cancel, pause, or
restart your print job.
If you installed Status Monitor 2, you also see information about
how much ink you have left and can view the Status Monitor 2
Printer Status window. See Using Status Monitor 2 for more
information.
You can also set up the way your printer software sends print jobs
and select whether to display the Progress Meter dialog box or not;
see Selecting the Speed & Progress Options for instructions.

Basic Printing
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Windows 3.1
After you send your print job, the EPSON Despooler dialog box
appears on your screen:

Click to pause
or resume
printing
Click to cancel
printing

Click to restart
printing

This dialog box shows the progress of your print job and the status
of your printer. If you run out of paper while printing, for example,
the Despooler warns you. You can use the buttons to cancel,
pause, or restart your print job.
You can also control print jobs using the Spool Manager; see Using
the Spool Manager for more information.

Basic Printing
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Printing from a Macintosh
Note:
On the Macintosh,
printer settings are
saved with your
document, but not
from one application
to another. If you
want to reuse
settings, you can
create document
templates for your
favorite applications.

When you print with a Macintosh, you need to check the printer
software settings in each application you use. This section
describes the settings you’ll need to check for all your everyday
printouts. See Advanced Printing for information about advanced
settings for special print jobs.
Follow these steps to print from a Macintosh:
1

Open a Macintosh application and select a file you want to
print.

2

Open the File menu and click Page Setup (Document Setup
in some applications). You see the Page Setup dialog box:

3

Choose your paper size, orientation, and other options as
described in Selecting Paper Options on a Macintosh and
click OK.

You can also create
custom setting groups
in your printer
software that you can
select each time you
open an application.
See Saving Custom
Settings for details.

Basic Printing
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4

Now open the File menu and click Print. You see the main
printer settings dialog box:

Click to
select your
media type
Click to
select
Automatic
mode
Use the Quality/Speed slider to select your print resolution

For printing at the
highest resolution
(1440 dpi), you need
to use plain paper,
Photo Paper or one of
the Photo Quality
media. For the best
printing at any
resolution, always use
EPSON media.

Basic Printing

5

Choose the number of copies and indicate which pages you
want to print.

6

Choose the Media Type you want to print on from the following
list:
◗

Plain Paper

◗

360 dpi Ink Jet Paper

◗

Photo Quality Ink Jet Paper

◗

Photo Paper

◗

Photo Quality Glossy Film

◗

Ink Jet Transparencies
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The type of paper you choose determines the print quality
(resolution) you can use. It’s very important to select the correct
setting for your paper. If you’re not sure which to choose, see
Selecting Special Media.

Note:
The Quality/Speed
slider is not available
for certain media
types.

7

Choose Color or Black ink.

8

Make sure the Mode option is set to Automatic. This is the
easiest way to get good printing results for all kinds of
documents, on all types of paper.

9

Set the slider to Quality or Speed. This lets you choose
between the fastest printing or the highest resolution for the
media you’re using. To select 1440 dpi on plain paper or any
other available resolution for your media, you need to access
the Advanced dialog box; see Customizing Print Quality and
Special Effects for instructions.

10 Click the
Layout icon and check the fit to page, watermark,
page layout, and print order settings. See Choosing Print
Layout Options on a Macintosh and Selecting Print Order
Options for details. Then click OK to return to the printer
settings dialog box.
11 To select background printing options for your print job before
you print, click the
Background Printing icon. See Setting
Up Background Printing Options for details.

Basic Printing
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12 If you want to preview your printout to view how the current
layout, watermark, print order, and orientation settings look,
click the
Preview icon, then click the Preview button. See
Using Print Preview on the Macintosh for details.
13 Click Print when you’re finished checking your settings.
If you chose background printing when you set up your printer,
you can continue working while your document is printing. See
Using Monitor3 for details.

Setting Up Background Printing Options
Before you print your document, you can set up the following
background printing options:
Note:
You can also turn
background printing
on or off in the
Macintosh Chooser.

◗

Turn background printing on or off

◗

Set a priority for the print job in the print queue

◗

Set a specific time for printing the print job

◗

Hold the print job for later printing

Follow these steps:

Basic Printing

1

Open an application and select a document you want to print.

2

Open the File menu and click Print. You see the printer
settings dialog box.

3

Click the

Background Printing icon.
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You see the following dialog box:

Not available if
background
printing is
turned off

4

To turn background printing on or off, click the On or Off radio
button.

5

To select a priority for your print job in the queue of jobs waiting
to print, click one of the following:

6

Basic Printing

◗

Normal to print in the order the job is received

◗

Urgent to print before any Normal priority job

◗

Print at: to print at the specific time you enter in the day and
time in the fields to the right

◗

Hold to hold the print job in the print queue until you’re
ready to release it using EPSON Monitor 3; see Using
Monitor3 for details.

Click OK to save your settings and return to the printer settings
dialog box. (Click Cancel if you want to cancel your settings
and return.)
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Advanced Printing
When your presentation graphics, photographs, or other projects
have special printing requirements, you can use the advanced
settings in your EPSON Stylus COLOR 740 software. You can
choose custom project types or adjust individual settings like
brightness, contrast, sharpness, and halftoning. For
professional-quality color accuracy, you can use a color matching
mode.
Your printer software’s print layout options let you print almost any
size image on your printer, proof multiple pages on one sheet of
paper, and add watermarks (not available with Windows 3.1).
This chapter includes the following information:
◗

Using Custom Project Types

◗

Customizing Print Quality and Special Effects

◗

Customizing Color Settings

◗

Using ColorSync on the Macintosh

◗

Selecting Paper Size and Orientation Options

◗

Selecting Print Layout Options

◗

Using Print Preview on the Macintosh

◗

Saving Custom Settings
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Using Custom Project Types
Custom project types provide an easy way to fine-tune your printer
settings for a specific type of project. Follow these steps to print
with custom project types:
1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh. You see one of the
following dialog boxes:

Click Custom, then click here
to see a list of project types

Windows 95, 98, NT
Advanced Printing

Click Advanced, then click here
to see a list of project types

Windows 3.1
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Click Custom, then
click here to see a list
of project types

Macintosh

Note:
Always choose your
Media Type and Ink
setting before you
select a custom
project type. Some
project types may not
be available with the
Media Type or Ink
settings you choose.
Printing with
PhotoEnhance3 or
PhotoEnhance may
take longer on some
systems and images.
Advanced Printing

3

Choose the Media Type you want to print on. (If you’re not sure
which setting to choose, see Selecting Special Media.)

4

Choose Color or Black ink.

5

Click Custom (in Windows 3.1, click Advanced), and then click
Custom Settings. You see the list of project types.

6

Choose the right setting for your project and Media Type
following these guidelines:
◗

PhotoEnhance3 (Windows 95, 98, NT, or Macintosh) or
PhotoEnhance™ (Windows 3.1)
For printing images captured using a video camera, digital
camera, or scanner. Produces sharper images and more
vivid colors by automatically adjusting the contrast,
saturation, and brightness. Corrects for overall under- and
over-exposure of the original image.
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Advanced Printing

◗

Digital Camera (not available with Windows 3.1)
For printing images captured using a scanner or digital
camera. Corrects noise and other common flaws.

◗

Text/Graph
For printing graphics-intensive documents like presentation
pages with charts and graphs. Intensifies colors and
lightens the midtones and highlights.

◗

Economy
For rough drafts of text only. Saves ink.

◗

ICM (Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible
application. If you’re using an ICM compatible monitor,
adjusts printed colors to closely match the screen colors.

◗

sRGB (Standard Red Green Blue; not available with
Windows 3.1; recommended only with Windows 98)
For printing documents created in an sRGB compatible
application using sRGB colors, such as those designed for
the World Wide Web. First set up your sRGB compatible
devices (such as your monitor and printer) to use an sRGB
color profile; see your Windows 98 online help for details.

◗

ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match the
colors on your screen. For more information, see Using
ColorSync on the Macintosh.
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7

In Windows, click the Paper and Layout tabs (not available on
Windows 3.1) to check or change any necessary settings, as
described in Selecting Paper Options in Windows and
Choosing Print Layout Options in Windows.
On a Macintosh, check or change any necessary settings on
the Page Setup and the Layout dialog boxes as described in
Selecting Paper Options on a Macintosh and Choosing Print
Layout Options on a Macintosh.

8

When you’re finished, click OK (Windows) or Print (Macintosh).
If you’re using Windows, click any other buttons that your
application uses for printing.

Customizing Print Quality and Special
Effects
After you customize
your print settings for
a special project, you
can save them as a
group. Then you can
reuse them whenever
you print a similar
project. See Saving
Custom Settings for
instructions.

Advanced Printing

If you need the maximum control over your project, or you want to
experiment with special effects, you can adjust the custom settings
in your printer software. Follow these steps:
1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3

Click Custom, and then click the Advanced button. (In
Windows 3.1, click Advanced, then click the More Settings
button.)
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You see the Advanced dialog box (called More Settings in
Windows 3.1):
Click here to
change your Print
Quality (resolution)
Some of these
options are
automatically set
or disabled by
other settings
you choose

Windows 95, 98, NT
Click here to
change your Print
Quality (resolution)

Some of these
options are
automatically set
or disabled by
other settings
you choose

Advanced Printing

Windows 3.1
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Click here to change
your Print Quality
(resolution)
Some of these
options are
automatically set
or disabled by
other settings
you choose

Note:
The available Print
Quality settings may
be limited by the
Media Type you
choose.

Advanced Printing

Macintosh

4

Choose the Media Type and Ink settings you want to use,
following the guidelines in Printing from Windows and Printing
from a Macintosh.

5

Choose one of the following Print Quality options:
◗

Economy
For low-resolution rough drafts on plain paper. Saves ink.

◗

Normal - 360 dpi
For most documents on plain paper, transparencies, or 360
dpi Ink Jet Paper.

◗

Fine - 720 dpi
For high-resolution output on plain paper, Photo Paper, or
Photo Quality Ink Jet Paper.
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Note:
In Automatic mode,
the Halftoning setting
is selected based on
the data in your print
job. In Custom mode,
Halftoning is
preselected for each
project type setting.
Some of the print
options at the bottom
left of the Advanced
dialog box are
automatically
selected or disabled
by the Print Quality
(resolution) you
choose.

Advanced Printing

6

7

◗

Photo - 720 dpi
Excellent high-resolution output on plain paper, Photo
Paper, or Photo Quality Ink Jet Paper.

◗

Photo - 1440 dpi
For the highest-resolution output on plain paper, Photo
Paper, or Photo Quality media.

Choose one of the following Halftoning options:
◗

No Halftoning
For printing black text only.

◗

Error Diffusion
For printing photographic images. Blends each color dot
with the dots around it.

◗

Fine Dithering
For printing graphs or other images that require precise,
solid areas of bright colors.

Choose any of the following print options:
◗

MicroWeave
For improved print quality. Prints graphic data in finer
increments to eliminate unwanted banding effects (light
horizontal lines). Always use for color printing.

◗

High Speed
For fast, bidirectional printing at lower quality. If vertical
lines in your printout are misaligned when you use the High
Speed setting, you may need to turn it off or align the print
head; see Aligning the Print Head for instructions.
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8

◗

Flip Horizontal
Prints a mirror image of your document. Use with iron-on
transfer paper so your ironed-on printout will read correctly.

◗

Finest Detail
For printing text, graphics, and line art with very sharp
edges. Slows print speed and increases your system
memory requirements.

Click OK if you’re ready to return to the printer settings dialog
box, or see Customizing Color Settings if you want to adjust
your document’s color settings.

Customizing Color Settings
There are three ways to manage the color in your documents using
your printer software:

Note:
The appearance of
the Color section of
the More Settings
dialog box always
appears as shown in
Using Custom Color
Management Modes
on Windows 3.1.

Advanced Printing

◗

Using PhotoEnhance3 or Digital Camera Correction Mode to
automatically correct digital photographs for exposure and
other common flaws, and to adjust the tone or sharpness.

◗

Using Custom Color Management Modes to select individual
color values to fine-tune the color in text, graphics, or economy
mode documents.

◗

Using a Color Correction System for maximum color accuracy.

The appearance of the Color Management section of the Advanced
dialog box changes, depending on the settings you’ve selected.
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Using PhotoEnhance3 or Digital Camera Correction
Mode
Note:
The Color
Management section
also changes to this
view if you select the
PhotoEnhance3 radio
button on the
Advanced dialog box.

To correct the exposure, tone, and sharpness of digital images, you
can use PhotoEnhance3 (PhotoEnhance on Windows 3.1) and/or
Digital Camera Correction mode (not available with Windows 3.1).
1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3

Click Custom, then select either PhotoEnhance3 or Digital
Camera as described in Using Custom Project Types.

4

Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:

Click to select a Tone
setting, if necessary.
Changes are shown
in the example
photograph.

Macintosh

Click to turn on
Digital Camera
Correction mode
and/or sharpen
the image.
Windows 95, 98, NT

Advanced Printing
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5

6

You can customize your image using these settings:
◗

Select a Tone setting for your image: Normal for standard
tones, Hard for high contrast, or Sepia for an old-fashioned
photo look.

◗

Turn on Digital Camera Correction to correct noise and
other flaws common to digital camera images.

◗

Select Sharpness to sharpen the image, especially the
edges.

Click OK to return to the printer settings dialog box.

Using Custom Color Management Modes
You can choose from several custom Color Management modes or
manually adjust brightness, contrast, saturation, and CMY (cyan,
magenta, yellow) color values.

Advanced Printing

1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3

Click Custom (in Windows 3.1, click Advanced), then select
either Text/Graph or Economy as described in Using Custom
Project Types.
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4

Note:
The Color
Management section
also changes to this
view if you did not
select a Custom
project type or if you
select the Color
Adjustment radio
button on the
Advanced dialog box.

Not available
with
Windows 3.1;
ICM not
available with
Windows NT

Windows

5

Advanced Printing

Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:

Macintosh

Choose one of the following Color Adjustment Modes:
◗

Automatic
Analyzes the color information in your project and optimizes
color correction accordingly.

◗

Photo-realistic
For printing color photographs.

◗

Vivid
For printing graphics-intensive documents like presentation
pages with charts and graphs. Intensifies colors and
lightens the midtones and highlights.
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◗

6

7
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No Color Adjustment
Disables the color adjustment features of the printer
software so you can use a stand-alone color management
utility.

If you want to specify individual color correction values, use the
sliders to increase (drag right) or decrease (drag left) the
settings listed below.
◗

Brightness
Makes your image lighter or darker.

◗

Contrast
Increases or decreases the difference between the bright or
dark parts of an image.

◗

Saturation
Makes colors more vivid or less vivid.

◗

Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink colors
that combine to make a full-color picture. Use these sliders
to fine-tune the color balance in your printout.

Click OK to return to the printer settings dialog box.
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Using a Color Correction System

Note:
The Color
Management section
also changes to this
view if you select the
ICM, sRGB, or
ColorSync radio
button on the
Advanced dialog box.

To achieve the maximum color accuracy, you can use Image Color
Matching (ICM; Windows 95 and 98 only), Standard Red Green
Blue (sRGB; Windows 95, 98, and NT only), or ColorSync
(Macintosh only), if your system is set up to use them.
1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3

Click Custom, then select either ICM (Windows 95 or 98 only),
sRGB (Windows 95, 98, and NT only), or ColorSync
(Macintosh only) as described in Using Custom Project Types.

4

Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:

For details, see
Using ColorSync
on the Macintosh

Not available
with
Windows NT

Windows 95, 98, NT

Advanced Printing

Macintosh
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5

6

Select one of these color correction systems:
◗

ICM (Windows 95 and Windows 98 only)
For printing documents created in an ICM compatible
application. If you’re using an ICM compatible monitor,
adjusts printed colors to closely match the screen colors.

◗

sRGB (Standard Red Green Blue; not available with
Windows 3.1; recommended only with Windows 98)
For printing documents created in an sRGB compatible
application using sRGB colors, such as those designed for
the World Wide Web. First set up your sRGB compatible
devices (such as your monitor and printer) to use an sRGB
color profile; see your Windows 98 online help for details.

◗

ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors on the
screen. See Using ColorSync on the Macintosh for more
information.

Click OK to return to the printer settings dialog box.

Using ColorSync on the Macintosh
Every device you use for producing or viewing colors—your
monitor, scanner, and printer—employs a different color
technology. The Macintosh ColorSync system helps you control all
your devices so their colors match your printer’s as closely as
possible.
Advanced Printing
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ColorSync uses profile information from each device—including
your EPSON Stylus COLOR 740 printer—to achieve accurate color
matching. First you have to make sure your monitor’s profile is set.
Then you can use your printer software to specify the exact method
of color matching you want to use.
Note:
When you install your
printer software, you
automatically install
the ColorSync profile
for your printer. If
your system doesn’t
have ColorSync, the
installer also
automatically installs
ColorSync 2.0. If you
already have
ColorSync 2.0, or a
later version, the
installer doesn’t
install ColorSync.

Advanced Printing

Follow these steps to set your monitor’s ColorSync profile and use
your printer software’s ColorSync features. The steps may be
different or there may be additional steps, depending on your
Macintosh OS version; see your Macintosh documentation for more
information on setting up ColorSync.
1

Open the ColorSync System Profile under Control Panels
on the Apple menu.

2

Click the Set Profile button.

3

Select your monitor from the list, and then click Select.

4

Close ColorSync System Profile.

5

Open an application and select a document to print.

6

Open the File menu and click Print.

7

Click Custom, then click Advanced. You see the Advanced
dialog box.

8

Click the ColorSync radio button.

9

For Profile, choose EPSON Standard. This is the ColorSync
profile created especially for your printer. Don’t choose any
other printer profile you may have on your system.
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10 Choose one of the following options for Rendering Intent:

Note:
The Rendering Intent
options may be
limited by the Media
Type you’ve selected.

◗

Perceptual
For printing scanned photographs.

◗

Saturation
For printing graphics-intensive documents like presentation
pages with charts and graphs.

◗

Colorimetric
For matching colors on your screen as exactly as possible.
Reproduces colors the way your eye distinguishes them.

11 Click OK to return to the printer settings dialog box.

Selecting Paper Size and Orientation
Options
Your printer can print on paper up to 9.5 inches wide and up to
44 inches long in either portrait or landscape orientation. If you print
multi-page documents or multiple copies of documents, you can
print the pages collated and in reverse order. You can even rotate
the printed document by 180 degrees to make it closer to the
bottom of the paper (not available with Windows 3.1).
Follow the steps in the section for your operating system:

Advanced Printing

◗

Selecting Paper Options in Windows

◗

Selecting Paper Options on a Macintosh
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Selecting Paper Options in Windows
Follow these steps to select paper options on the Paper tab:
1

Create your image or document in your application software.

2

Access the printer settings dialog box as described in Printing
from Windows.

3

Click the Paper tab. You see the Paper dialog box:

Printer graphic
reflects changes
to Orientation and
Printable Area
settings

Advanced Printing

Click to select
your Paper
Size
Page graphics
change to
show Collate
and Reverse
Order settings
Rotate by 180°
is not available
with
Windows 3.1
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4

The sizes marked with an asterisk (*; not available with
Windows 3.1) are larger than you can load in the printer and
can be used only with the Reduce/Enlarge setting on the
Layout tab; see Reducing and Enlarging Your Document Size
for more information.
A4 210 × 297 mm
Envelope 132 × 220 mm
B5 182 × 257 mm
Photo Paper 4 × 6 in
A5 148 × 210 mm
Panoramic 210 × 594 mm
×
Letter 8 1/2 11 in
B4 257 × 364 mm *
Legal 8 1/2 × 14 in
US B 11 × 17 in *
×
Executive 7 1/4 10 1/2 in
A3 297 × 420 mm *
Half Letter 5 1/2 × 8 1/2 in
Super A3/B 329 × 483 mm *
A6 Index card 105 × 148 mm
B3 364 × 514 mm *
Index card 5 × 8 in
A2 420 × 594 mm *
×
Index card 8 10 in
US C 17 × 22 in *
Envelope #10 4 1/8 × 9 1/2 in
User Defined (See Creating
×
Envelope DL 110 220 mm
User Defined Paper Sizes for
Envelope C6 114 × 162 mm
instructions.)

Note:
If the Reduce/Enlarge
setting is set to
Normal and you
select one of the
paper sizes to the
right that is marked
with an asterisk (*),
you see a dialog box
asking you to select a
paper size that fits
your printer. See
Reducing and
Enlarging Your
Document Size for
more information.

5

Advanced Printing

Click the Paper Size drop-down list to select the size of paper
you loaded in the printer.

If you did not or cannot select the number of copies you want to
print in your application program’s Print dialog box, choose the
number in the Copies box. Don’t select the number of
copies here and in your application’s Print dialog box; you
may get twice the number of copies you want.
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Note:
The Rotate by 180°
setting lets you print
the lower portion of a
document first, with a
bottom margin as
small as 0.12 inch (3
mm) and a top margin
as small as 0.55 inch
(14 mm). This option
is not available with
Windows 3.1.
When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.
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6

If you’re printing multiple copies of a multi-page document and
you want the copies printed in sets, click the Collate checkbox.
The page graphics change to show collated documents.

7

If you’re printing a multi-page document and want the last page
printed first so the pages come out without needing to be
reordered, click the Reverse Order checkbox. The page
graphics change to show later pages printing first.

8

Select the direction of printing on the page with the Orientation
options. To print your document oriented as shown in one of
the following illustrations, select the options listed below it.

Portrait

9

Portrait and
Rotate by 180°

Landscape

Landscape and
Rotate by 180°

The Standard Printable Area setting uses the maximum
printable area of your paper with a minimum bottom margin of
0.55 inch (14 mm). To increase the minimum bottom margin to
0.12 inch (3 mm), set the Printable Area setting to Maximum.
To center your document on the page using either setting,
select the Centered checkbox.
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10 Click a tab for the settings you want to check or change next, or
click OK to print your document.

Creating User Defined Paper Sizes
You can create up to 10 custom paper sizes (one in Windows 3.1)
and add them to the Paper Size list using the User Defined option.
This is useful if you’re printing a custom size document, such as a
banner. You can select any width from 3.5 to 9.5 inches, and any
height (length) from 3.5 to 44 inches.
Follow these steps to create a User Defined paper size:
1

Follow the steps in Printing from Windows to access the printer
software, then click the Paper tab.

2

Click the Paper Size list and scroll to the bottom of it using the
arrows or scroll bar.

3

Click the User Defined option. You see one of the following
dialog boxes:

Windows 3.1
Windows 95, 98, NT
Advanced Printing
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4

Note:
In Windows 95, 98,
and NT, the Paper
Width and Paper
Height units are in
hundredth of an inch
(or centimeter)
increments. For
example, 850 equals
8.50 inches.

Windows 95, Windows 98, or Windows NT
Type a name (up to 24 characters) for your custom paper size
in the Paper Size Name field. Then select a Paper Width and
Paper Height for the paper. To use centimeters instead of
inches, click the 0.01cm option. When you’re finished, click
Save. The paper size name appears in the Paper Size list in
the dialog box. Add more sizes if you want, and click OK when
you’re done.
Windows 3.1
You can create only one User Defined paper size. Type the
width in the Paper Width field and the length in the Paper
Height field. Then click OK.

5

You see the Paper tab again. The paper size name you defined
is added to the Paper Size list and selected as the current
setting. (In Windows 3.1, the setting is named User Defined.)

6

Click a tab for the settings you want to check or change next, or
click OK to print your document

To change or delete a custom paper size:
Windows 95, Windows 98, or Windows NT
Click User Defined in the Paper Size list. Then, on the User
Defined Paper Size dialog box, select the custom paper name in
the Paper Size list and change the Paper Width, Paper Height,
and/or Unit settings as necessary, or click Delete. Click OK when
you’re done.

Advanced Printing
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Windows 3.1
You can change the custom paper size, but cannot delete it. Click
User Defined in the Paper Size list. Then, on the User Defined
Paper Size dialog box, change the Paper Width and Paper Height
settings as necessary. Click OK when you’re done.

Selecting Paper Options on a Macintosh
The Paper Size and Orientation options for your printer software
are on the Page Setup dialog box. The options for collating and
reversing the page order are on the Layout dialog box. Follow the
steps in these sections for selecting the paper options:

Advanced Printing

◗

Choosing Paper Size and Orientation Options

◗

Selecting Print Order Options
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Choosing Paper Size and Orientation Options
Follow these steps to select the Paper Size and Orientation:
1

Create your image or document in your application software.

2

Open the File menu and select Page Setup. You see the Page
Setup dialog box:
Click to select
your Paper Size

Printer graphic
reflects changes
to Orientation
and Printable
Area settings

Click to select your
Orientation options
Click to select
your Printable
Area options

3

Advanced Printing

Click the Paper Size pop-up list to select the size of paper you
loaded in the printer.
A4 210 × 297 mm
Index card 5 × 8 in
B5 182 × 257 mm
Index card 8 × 10 in
A5 148 × 210 mm
Envelope #10 4 1/8 × 9 1/2 in
Letter 8 1/2 × 11 in
Envelope DL 110 × 220 mm
Legal 8 1/2 × 14 in
Envelope C6 114 × 162 mm
Executive 7 1/4 × 10 1/2 in
Envelope 132 × 220 mm
Half Letter 5 1/2 × 8 1/2 in
EPSON Photo Paper 4 × 6 in
A6 Index card 105 × 148 mm
Panoramic 210 × 594 mm
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If you don’t see the exact size you need, you can create a
custom paper size; see Creating custom paper sizes.
4
Note:
The Rotate by 180°
setting lets you print
the lower portion of a
document first, with a
bottom margin as
small as 0.12 inch
(3 mm) and a top
margin as small as
0.55 inch (14 mm).
When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.

Select the direction of printing on the page with the Orientation
options. To print your document oriented as shown in one of
the following illustrations, select the options listed below it.

Portrait

Portrait and
Rotate by 180°

Landscape

Landscape and
Rotate by 180°

5

The Standard Printable Area setting uses the maximum
printable area of your paper with a minimum bottom margin of
0.55 inch (14 mm). To increase the minimum bottom margin to
0.12 inch (3 mm), set the Printable Area setting to Maximum.
To center your document on the page using either setting,
select the Centered checkbox.

6

To collate multiple copies of a multi-page document or reverse
the order in which pages are printed, see Selecting Print Order
Options for instructions.
If you’ve finished selecting options, click OK to close the Page
Setup dialog box. Then select Print from the File menu to print
your document.

Advanced Printing
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Creating custom paper sizes
You can create up to 8 custom paper sizes and add them to the
Paper Size list. This is useful if you’re printing a custom size
document, such as a banner. You can select any width from 3.5 to
9.5 inches, and any height (length) from 3.5 to 44 inches.
Follow these steps to create a custom paper size:

Advanced Printing

1

Open your application’s File menu and select Page Setup.

2

Click the Customize button. You see the following dialog box:

3

Click the New button. Width and Height fields and Inches and
cm radio buttons appear on the screen.

4

Type the width and length of your custom paper in the Width
and Height fields. If you need to change from inches to
centimeters, click the correct radio button.

5

Type a name for your paper size in the New Paper Size field,
then click OK. The name is added to the Paper Size list and
selected as the current setting in the Page Setup dialog box.
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6

To delete a custom paper size, click the Customize button.
Then click the name of the custom paper size, and click Delete.
Click OK to return to the Page Setup dialog box.

Selecting Print Order Options
Follow these steps to use the Collate and Reverse Order options:
1

Open your application program’s File menu and select Print.

2

Click the

Layout icon. You see the Layout dialog box:

Note:
For information on
the other settings on
the Layout dialog
box, see Choosing
Print Layout Options
on a Macintosh.
Print Order options

3
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If you’re printing multiple copies of a multi-page document and
you want the copies printed in sets, click the Collate checkbox.
The page graphics change to show collated documents.
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4

If you’re printing a multi-page document and want the last page
printed first so the pages come out without needing to be
reordered, click the Reverse Order checkbox. The page
graphics change to show later pages printing first.

5

Click OK to close the Layout dialog box.

Selecting Print Layout Options
The print layout options let you reduce or enlarge almost any size
document to print on your printer. You can also select options to
proof multiple pages on one sheet of paper, add page frames, and
add a predefined or custom watermark.
Note:
Layout options are not
available with
Windows 3.1.

Follow the steps in the section for your operating system:
◗

Choosing Print Layout Options in Windows

◗

Choosing Print Layout Options on a Macintosh

Choosing Print Layout Options in Windows
Follow the steps in these sections to use options in the Layout
dialog box:

Advanced Printing

◗

Reducing and Enlarging Your Document Size

◗

Using Multiple Print Layouts and Page Frames

◗

Adding a Watermark
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Reducing and Enlarging Your Document Size
When you want to make the printed size of a document different
from its actual size, you can use your printer software’s
Reduce/Enlarge settings. You can make the document fit into the
printable area on a selected paper size or you can choose to
reduce or enlarge it to a selected percentage.
Follow these steps to reduce or enlarge your document size:
1

Follow the steps in Printing from Windows to access the printer
settings dialog box, then click the Paper tab.

2

Click the Paper Size list and select the actual size of the
document you want to print.
For example, if your document size is 11 × 22 inches, select
US C 11 × 22 in. This paper size is too large to fit in your
printer, so you’ll need to proportion it to fit on a smaller paper
size (by reducing the document size). If your document size is
5 × 8 inches, but you want it to fit in the maximum area on
Letter-size paper, you’ll need to proportion it to fit on a larger
paper size (by enlarging the document size).

3

Advanced Printing

If the Paper Size setting you selected for your document is
within the maximum paper size that can fit on your printer, but
you want to enlarge or reduce the document, you need to
select the reduction/enlargement manually. Go to step 5.
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4

If the Paper Size setting you selected is larger than the
maximum size that can be printed on your printer, you see the
following dialog box:

Output Paper
list

In the Output Paper list, select the actual size of the paper
loaded in the printer and click OK. This automatically turns on
the Fit to Page setting so the document fits into the printable
area on the output paper you select.
The selected Paper Size, reduction percentage, and Output
Paper settings now appear above the printer graphic.
Paper Size
setting
reduction
percentage
Output Paper
setting

Advanced Printing
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If you want to adjust the proportions or sizes, go to step 5. If
you’re ready to print, go to step 7.
5

Click the Layout tab. You see the Layout dialog box:

Reduce/Enlarge
settings

Advanced Printing
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6

Select one of the following Reduce/Enlarge settings:
◗

Select Normal to set the print proportion to 100%.

◗

Select Fit to Page to automatically reduce or enlarge the
document to fit on the paper size loaded in the printer. The
Paper Size option beneath the Fit to Page setting becomes
active; select the size of paper loaded in the printer.

Note:
If you previously
selected a Paper Size
setting that is larger
than the maximum
paper size for your
printer and then
choose Normal, the
Paper Size changes to
Letter 8 1/2 × 11 in.

Select Fit to Page,
then select the size
of paper loaded in
the printer here

◗

7

Select Custom, then select a percentage (10% to 400%) in
the Scale to: field to reduce or enlarge the document by a
specific amount.

If you’re finished selecting Layout options, click OK.
If you want to select more options, see Using Multiple Print
Layouts and Page Frames.

Advanced Printing
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Using Multiple Print Layouts and Page Frames
If you’re printing a multiple page document, but you want a quick
proof of the images on each page printed on one piece of paper,
you can select Print Layout options in the printer software. You can
choose the way the pages are placed on the paper and add a lined
frame to each page, if you want.
Follow these steps to use the Print Layout options:
1

Follow the steps in Printing from Windows to access the printer
settings dialog box.

2

Click the Layout tab. You see the Layout dialog box.

3

To print multiple pages of your document on one sheet of
paper, select either the 2 Pages or 4 Pages radio button.
Click a button to
select a multiple
page print layout

4

If the page order of the layout shown in the on-screen graphic is
how you want your document printed, go to step 3.
To change the page order, click the Page Order button. Then
select the page order you want to use from the Print Layout
dialog box that appears.

Advanced Printing
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5

If you want to frame each page’s contents with a black line, one
dot wide, click the Print page frames checkbox.

6

If you’re finished selecting Layout options, click OK. If you want
to select more options, see Adding a Watermark.

Adding a Watermark
Note:
To add a custom
watermark, you must
first create the
watermark as a bitmap
in an application
program that can
create bitmap files.
See your application’s
documentation for
instructions.
If you selected a
multiple page print
layout option (as
described in Using
Multiple Print Layouts
and Page Frames),
your watermark will
appear on each page
in the layout.
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You can add a watermark to each page in your document to
emphasize its purpose or indicate how the document should be
handled. For example, you may want to add a watermark of the
word “Confidential” to documents you don’t want distributed to other
parties. Or you can add a custom bitmap of your company logo so
your document looks like printed letterhead.
Follow these steps to add a watermark:
1

Follow the steps in Printing from Windows to access the printer
settings dialog box.

2

Click the Layout tab. You see the Layout dialog box.

3

To select a watermark, click in the WaterMark drop-down list.
WaterMark
drop-down list
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Then highlight one of the following watermarks:
Confidential
Do Not Copy
Draft
For Your Eyes Only
Urgent
Review Copy
Priority
Top Secret
Hot
Duplicate
To turn off your watermark, select None from the drop-down
list.
4

To change the watermark or specify how it appears, click the
Settings button. You see the following dialog box:
Click here to select a
predefined watermark

See how your
selections will
look in the
Layout
graphic

5

Advanced Printing

Click here to load a
custom watermark
you’ve created
Specify how you want
your watermark to look
using these options

To load a custom watermark you’ve created as a bitmap file in
an application program, click the User Defined button.
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You see the following dialog box:

Note:
You can create up to
10 custom watermarks.
In Windows 95 and 98,
you can use any
bitmap file up to
15MB in size. With
Windows NT, the file
can be any size.
To delete a custom
watermark from the list,
click the User Defined
button, select the
watermark, and click
Delete.

Advanced Printing

Click Browse to select
your bitmap file
Then type a name
for your custom
watermark here
and click Save

Click the Browse button. You see a file selection dialog box.
Navigate to the folder containing the bitmap file you want to
use, select the file, and click OK.
Type a name for the custom watermark (up to 24 characters
long) in the Watermark field. Click the Save button to add it to
the list, then click OK.
The custom watermark now appears as the selected watermark
in the Watermark Settings dialog box and is shown in the
on-screen graphic.
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6

Note:
If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic. If you choose
the No Halftoning
setting, the Intensity
setting does not
determine how your
watermark is printed.

Advanced Printing

7

Now select the way you want the watermark to appear by
choosing the following options. The on-screen graphic changes
to reflect all the settings you choose.
◗

Position selects where you want the watermark to appear
on your page: Center, Top-Left, Top-Center, Top-Right,
Left, Right, Bottom-Left, Bottom-Center, or
Bottom-Right.

◗

Size adjusts the size of the watermark, either larger or
smaller, as you move the slide bar.

◗

Color lets you choose a color for your predefined
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia, or
Yellow. You cannot select a color for a custom watermark;
it is printed in its original colors.

◗

Intensity sets the lightness or darkness of the watermark
(from 5% to 100%) based on where you move the slide bar.

If you’re finished changing Layout options, click OK to close the
Layout dialog box.
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Choosing Print Layout Options on a Macintosh
Follow the steps in these sections to use options in the Layout
dialog box:
◗

Using the Fit to Page Option

◗

Using Multiple Print Layouts and Page Frames

◗

Adding a Watermark

Using the Fit to Page Option
When you want to make the printed size of a document different
from its actual size, you can use your printer software’s Fit to Page
option to proportion it to fit in the maximum, centered area on a
selected paper size.
Follow these steps to use the Fit to Page option:
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1

Create your image or document in your application software.

2

Open the File menu and select Page Setup. You see the Page
Setup dialog box.

3

Click the Paper Size list and select the actual size of the
document you want to print. For example, if your document
size is 8 1/2 × 11 inches, select Letter for the Paper Size
option.

Page 70

If you want to print this document on 4 × 6-inch EPSON Photo
Paper, you’ll use the Fit to Page setting to reduce the
document to that size. If you want to print this document on
Legal-size paper (8 1/2 × 14 inches), you’ll use the Fit to Page
setting to enlarge the document to that size.
4

Click OK to close the Page Setup dialog box.

5

Now open the File menu and select Print. You see the printer
settings dialog box.

6

Click the

Layout icon. You see the Layout dialog box:

Fit to Page
settings

7
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Select one of the following Fit to Page options:
◗

Select Off to set the print proportion to 100%.

◗

Select On to automatically reduce or enlarge the document
to fit on the paper size loaded in the printer.
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The Paper Size option beneath the Fit to Page setting
becomes active.

Select the paper size you’ve
loaded in the printer here
Paper graphic displays the selected
paper size and
document size

Now select the size of the paper you’ve loaded in the
printer. This automatically sets the correct reduction or
enlargement percentage to fit the document into the
printable area on the selected paper size. The selected
document size and paper size settings now appear beneath
the paper graphic.
8

If you’re finished selecting Layout options, click OK.
If you want to select more options, see Using Multiple Print
Layouts and Page Frames.
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Using Multiple Print Layouts and Page Frames
If you’re printing a multiple page document and you want a quick
proof of the images on each page printed on one piece of paper,
you can select Print Layout options in the printer software. You
can choose the way the pages are placed on the paper and add a
lined frame to each page, if you want.
Follow these steps to use the Print Layout options:
1

Open an application and select a document to print.

2

Open the File menu and click Print. You see the printer
settings dialog box.

3

Click the

4

To print multiple pages of your document on one sheet of
paper, select either 2 Pages or 4 Pages in the Pages pop-up
list.

Layout button. You see the Layout dialog box.

Click the arrow and
select a multiple page
print layout

5

If the page order of the layout shown in the printer graphic is
how you want your document printed, go to step 6.
To change the page order, click the arrow in the Page Order
pop-up list. Then select the page order you want to use.
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6

If you want to frame each page’s contents with a black line, one
dot wide, click the Print page frames checkbox.

7

If you’re finished selecting Layout options, click OK. If you want
to select more options, see Adding a Watermark.

Adding a Watermark
Note:
To add a custom
watermark, you must
first create the
watermark as a PICT
file in an application
program that can
create PICT files. See
your application’s
documentation for
instructions.
If you selected a
multiple page print
layout option (as
described in Using
Multiple Print Layouts
and Page Frames),
your watermark will
appear on each page
in the layout.
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You can add a watermark to each page in your document to
emphasize its purpose or indicate how the document should be
handled. For example, you may want to add a watermark of the
word “Confidential” to documents you don’t want distributed to other
parties. Or you can add a custom PICT file of your company logo so
your document looks like printed letterhead.
1

Open an application and select a document to print.

2

Open the File menu and click Print.

3

In the printer settings dialog box, click the
You see the Layout dialog box.

4

To use one of the predefined watermarks, click the arrow in the
Name list in the Watermark box and choose one of these:
Confidential
Do Not Copy
Draft
For Your Eyes Only
Urgent
Review Copy
Priority
Top Secret
Hot
Duplicate

Layout button.

Go to step 6.
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5

To load a custom watermark you’ve created as a PICT file in an
application program, click the Add/Delete button. You see the
following dialog box:

Note:
You can create up to
10 custom watermarks
from PICT files up to
1MB in size.

Click the Add button
to select a PICT file

To delete a custom
watermark from the
list, click the
Add/Delete button,
select the watermark,
and click Delete.

Click the Add button. You see a dialog box for selecting files.
Navigate to the folder containing the PICT file you want to use,
select the file, and click Open.
The name of your PICT file appears in the Mark Name field and
is added to the Watermark List. Click the Save button to close
the dialog box.
The custom watermark now appears as the selected watermark
in the Layout dialog box and is shown in the layout graphic.
6

Now select the way you want the watermark to appear by
choosing the following options. The layout graphic changes to
reflect all the settings you choose.
◗

Advanced Printing

Color lets you choose a color for your predefined
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia, or
Yellow. You cannot select a color for a custom watermark;
it is printed in its original colors.
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Note:
If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic. If you
choose the No
Halftoning setting,
the Intensity setting
does not determine
how your watermark
is printed.

◗

Intensity sets the lightness or darkness of the watermark
(from 5% to 100%) based on where you move the slidebar.

◗

To adjust the size and position of the watermark, move the
cursor over the Layout graphic. Four boxes appear in the
corners of the graphic and the cursor changes to a hand.

Click and drag
anywhere in here to
move the watermark
Click and drag one of
the corner boxes to
resize the watermark

To move the watermark, click anywhere inside the graphic
and drag it into one of these positions: center, top-center,
upper-right, middle-right, lower-right, bottom-center,
upper-left, middle-left, or lower-left.
To resize the watermark, move the cursor over one of the
corner boxes; the cursor changes to a pointing hand. Click
and drag the box corner to reduce or enlarge the
watermark.
7
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If you’re finished changing Layout options, click OK to close the
Layout dialog box.
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Using Print Preview on the Macintosh
You can get a preview of how your document will print with the Print
Preview feature in your Macintosh printer software. Print Preview
shows the results of the following printer software settings on your
document:
◗

Print layout settings such as Fit to Page, Page Order,
Watermark, Reverse Order, and Collate

◗

Page Setup options, such as Paper Size, Orientation, Rotate
by 180°, and Printable Area

1

Open an application and select a document to print.

2

Open the File menu and click Print. You see the printer
settings dialog box.
Click the Print Preview icon
The Print button
changes to the
Preview button

Advanced Printing
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3

Click the
Print Preview icon. The Print button changes to
the Preview button.

4

Click the Preview button. You see the print preview dialog box:
Help, Cancel,
and Print buttons

Page control
buttons
Preview
image

Preview sizing
buttons

5

The first preview page is the first page of your document. To
change the preview page, click the
or
button to go back
or forward one page, or enter a page number in the Page field.

6

To change the size of the preview, click the following buttons:

7
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◗

Click

to preview the entire page in the display area

◗

Click

to enlarge the preview

◗

Click

to enlarge the preview even further

To print your document, click Print. To close the print preview
dialog box and return to your application, click Cancel.
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special project,
you can save the settings as a group. Then you can quickly reuse
them the next time you print a similar project. You can save up to
10 (Windows) or 8 (Macintosh) groups of settings.
1

Customize your printer settings, then access the Advanced
dialog box as described in Customizing Print Quality and
Special Effects.
(In Windows 3.1, access the main printer settings dialog box as
described in Printing from Windows, then click Advanced.)

2

Click the Save Settings button. You see this dialog box:

Macintosh

Windows

3

Advanced Printing

Type a unique name for your settings (up to 16 characters) and
click the Save button.
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4

Click OK to close the Advanced dialog box (not necessary with
Windows 3.1).

To use the settings, click Custom (in Windows 3.1, click
Advanced). Then open the Custom Settings list and double-click
the name you selected for your custom settings group. (On a
Macintosh, the custom settings group is automatically selected.)
To redefine or delete your custom settings, see Redefining Custom
Settings or Deleting Custom Settings.

Redefining Custom Settings
To change the options in a customized settings group but keep the
same name for it, follow these steps:

Advanced Printing

1

From the main printer settings dialog box, click Custom (in
Windows 3.1, click Advanced). Then select the name of the
custom settings group you want to redefine in the Custom
Settings list.

2

Click the Advanced button (in Windows 3.1, click More
Settings) and change the printer settings. (If you change the
Media Type and Ink settings, you’ll need to create a new
custom setting group instead of redefining an existing one.)

3

When you’re finished redefining settings, click Save Settings.
(In Windows 3.1, click OK to close the More Settings dialog box
and the click Save Settings on the main printer settings dialog
box.)
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4

Select the name of the custom settings group you’re redefining
in the Custom Settings dialog box.

5

If you’re using Windows, click Save. You see the Save As
dialog box. Click OK to save your redefined settings. (Click
Cancel to cancel your changes.)
On a Macintosh, click the Redefine button. Then click Replace
at the confirmation dialog box to save your redefined settings.
(Click Cancel to cancel your changes.)

Deleting Custom Settings
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1

From the main printer settings dialog box, click Custom, then
click the Advanced button. Click Save Settings on the
Advanced dialog box. (In Windows 3.1, click Advanced, then
click Save Settings on the main printer settings dialog box.)

2

Select the custom settings group in the Custom Settings box,
and click Delete. Then click OK to confirm the deletion, if
necessary. (You cannot delete any of the predefined document
types.)
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Printing on Special Media
Your EPSON Stylus COLOR 740 lets you print on just about any
kind of paper you want to use. You can get great results printing on
various sizes of plain paper, letterhead, and envelopes, but you’ll
get even better results with specially coated ink jet paper.
For the best output, use EPSON’s photo-quality paper: ink jet
paper, glossy paper, glossy film, note cards, and photo paper. For
special projects, you can use a variety of EPSON media designed
for ink jet printers, ranging from transparencies to iron-on transfer
paper.
Follow the steps in this chapter on:
◗

Selecting Special Media

◗

Media Loading and Handling Guidelines
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Selecting Special Media
When you print on special media, you need to choose the correct
Media Type and Paper Size settings in your printer software. The
table below lists the available EPSON media and the corresponding
Media Type setting for each one.
Media name

Size

Part number

Media Type setting

EPSON 360 dpi Ink Jet Paper

Letter
A4

S041060
S041059

360 dpi Ink Jet
Paper

EPSON Cool Peel Iron-On
Transfer Paper

Letter

S041153/S041155

EPSON High Quality Ink Jet Paper Letter
A4

S041111
S041117

EPSON Photo Quality Ink Jet
Paper

Letter
A4
Legal

S041062
S041061
S041067

EPSON Photo Quality Ink Jet
Cards

A6
8 × 10 inches

S041054
S041122

EPSON Photo Quality Self
Adhesive Sheets

A4

S041106

Printing on Special Media

Photo Quality Ink
Jet Paper
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Media name

Size

Part number

Media Type setting

EPSON Photo Quality Glossy
Paper

Letter
A4

S041124
S041126

Photo Paper

EPSON Photo Paper

4 × 6 inches
Letter
A4
Panoramic

S041134
S041141
S041140
S041145

EPSON Photo Quality Glossy Film Letter
A4
A6

S041072
S041071
S041107

EPSON Photo Stickers Kit
(CD-ROM and paper)
EPSON Photo Stickers (refill)

A6

S041144-KIT

A6

S041144

EPSON Ink Jet Transparencies

Letter
A4

S041064
S041063

Photo Quality
Glossy Film

Ink Jet
Transparencies

To order EPSON papers and other media, contact your dealer or
call EPSON Accessories at (800) 873-7766 or visit our web site at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.

Printing on Special Media
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Media Loading and Handling Guidelines
The following tips help you get the best results on any type of
paper:
Caution:
Don’t use the cleaning
sheets that may be
included with your
special media; they
may jam inside the
printer.

Printing on Special Media

◗

Always handle sheets by the edges, and don’t touch the
printable surface.

◗

When you load paper, make sure the printable side is
facing up.

◗

You can load paper up to the arrow mark on the left edge
guide.

◗

Return unused sheets and envelopes to their original package
as soon as possible. See Paper for more storage information.

◗

If your paper package included protective sheets, cover the
printed side of your paper with these sheets before stacking
your paper.

◗

Use ink jet papers within one year of purchase. Use glossy
media and transparencies within six months.

◗

Follow any specific instructions for your paper in the following
sections:
◗

Letterhead, Preprinted Forms, and Legal-size Paper

◗

EPSON Photo Quality Glossy Paper, Film, and
Transparencies

◗

Envelopes
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◗

EPSON Photo Paper

◗

EPSON Photo Quality Ink Jet Cards

◗

EPSON Photo Stickers

◗

EPSON Photo Quality Self Adhesive Sheets

◗

EPSON Cool Peel Iron-On Transfer Paper

Letterhead, Preprinted Forms, and Legal-size Paper
Load the top edge first. When you load long paper, pull up the
paper support extension and both output tray extensions.

EPSON Photo Quality Glossy Paper, Film, and
Transparencies
Before you load glossy film or transparencies, put a support sheet
(packed with the media) or a plain paper sheet beneath the stack.
(Don’t use a support sheet with Photo Quality Glossy Paper.)
You can load up to 20 sheets of glossy paper or glossy film, or up to
30 transparencies.
On Photo Quality Glossy Film, you may get better results by loading
one sheet at a time. With multiple sheets loaded, the minimum top
margin you can use is 1.2 inches (30 mm). If you want to use a
smaller top margin, load and print one sheet at a time.

Printing on Special Media
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If your media has a cut corner, position it in the printer as shown
here.
cut corner
Note:
It is best not to use
the Maximum
printable area setting
in the printer software
when printing on
paper with a cut
corner. Part of your
document may print
in the cut out area.

Printing on Special Media

Remove each sheet from the output tray immediately after it’s
printed. Make sure each sheet is dry before stacking.

Page 87

Envelopes
You can load up to 10 envelopes flap edge first, with the printable
side up, as shown below:
Note:
If the stack of
envelopes is more
than 0.4-inch
(10 mm) thick, press
the envelope edges
to flatten them before
stacking or load one
envelope at a time.

Select Plain paper as the Media Type and choose the correct
envelope size as the Paper Size setting in the printer software.
If ink smears when you print on envelopes or other thick media, set
the paper thickness lever to the + position as shown below. (Return
the lever to the 0 position before printing on other media.)

Printing on Special Media
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EPSON Photo Paper
You can use EPSON Photo Paper to print photographs that look
almost as good as the ones you get from film processing. 4 × 6-inch
Photo Paper is perforated around the edges, so you can trim your
printouts and “bleed” the photo—extend it to the edge of the
paper—on all sides.

Note:
To keep your
printouts looking their
best, store them in a
resealable plastic bag
or other airtight
covering and protect
them from heat,
humidity, and direct
sunlight.
Be sure to support
your Panoramic
Photo Paper as it
ejects from the printer
so it doesn’t fall onto
the floor.
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You can load up to 20 sheets of 4 × 6-inch, Letter-size, or A4-size
Photo Paper or 1 sheet of Panoramic paper at a time. Make sure
you place a support sheet beneath the paper if it is included in the
paper package.
Keep the following in mind when using EPSON Photo Paper:
◗

Load the paper with the whiter (glossier) side facing up.

◗

If you’re loading Panoramic Photo Paper, pull up the paper
support extension. Then load the Panoramic paper and hold up
its top edge while you press the E load/eject button to feed it
into the printer.
Select Photo Paper as the Media Type setting and
Panoramic 210 × 594 mm as the Paper Size setting.
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◗

If you’re loading 4 × 6-inch Photo Paper, follow these steps:
1

Position the perforated margins as shown and load up to
20 sheets with support sheets A and B beneath the stack.

2

When you create the image you’ll print in your application
software, size it to 4.25 × 6.25 inches so the image covers
the perforations as shown.
0.67 in

Trim size
Printed image size

0.24 in
0.12 in

0.12 in 0.24 in
Printing on Special Media
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3

You can use
4 × 6-inch EPSON
Photo Paper like a
postcard. After
printing on the glossy
side of the Photo
Paper, let your image
dry completely.
Then set the paper
thickness lever to the
+ position, reload the
flattened card with
the uncoated side up,
and print your
message in black ink
using 360 dpi Ink Jet
Paper as the Media
Type setting.
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Choose these printer software settings:
Photo Paper as the Media Type setting
EPSON Photo Paper 4 × 6 in as the Paper Size setting
Maximum as the Printable Area setting

4

After you print, fold the paper back and forth along the
perforations and carefully tear the margins off.
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EPSON Photo Quality Ink Jet Cards
You can load up to 30 cards at a time. Always place the included
support sheet under the cards and load them as shown below.

Make sure you set the paper thickness lever to the + position as
shown in Envelopes. When you’re ready to print, set the Media
Type to Photo Quality Ink Jet Paper and the Paper Size setting to
the card size in your printer software.

Printing on Special Media
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EPSON Photo Stickers
Use these sheets of stickers to print small, decorated photos for
use on cards, invitations, or other items. You’ll need to use an
application that can create photo stickers, such as StickerPix.™
Load one sheet of Photo Stickers at a time. Make sure to place
support sheets A and B that came with the stickers beneath the
sheet.
When you’re ready to print, select Photo Quality Glossy Film as
the Media Type setting and A6 Index card 105 × 148 mm as the
Paper Size in your printer software.

EPSON Photo Quality Self Adhesive Sheets
Use these sheets to print labels or stickers. You can load one sheet
at a time. Make sure your adhesive sheets are fully adhered to their
backing sheet before you load them.
When you’re ready to print, select Photo Quality Ink Jet Paper as
the Media Type setting in your printer software.

Printing on Special Media
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EPSON Cool Peel Iron-On Transfer Paper
You can print photos, company logos, or anything else you want on
these transfer papers, and then iron your images onto T-shirts or
other cloth items.
Load one sheet of transfer paper at a time. Select 360 dpi Ink Jet
Paper as the Media Type setting.
Make sure you reverse your image before you print it—especially if
it includes text—so it will read correctly when it’s transferred. You
can use the Flip Horizontal setting in your printer software to do
this (see Customizing Print Quality and Special Effects for
instructions).
After you print, follow the instructions that came with the paper to
iron the image onto the shirt or other item.

Printing on Special Media
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Managing Print Jobs
Your printer software includes several utilities for managing print
jobs. You can use them to monitor your printer’s status and check
on the current print job or jobs waiting to print.
This chapter provides instructions for the following:
◗

Managing Print Jobs in Windows 95, Windows 98, and
Windows NT 4.0

◗

Managing Print Jobs in Windows 3.1

◗

Managing Print Jobs on a Macintosh
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Managing Print Jobs in Windows 95,
Windows 98, and Windows NT 4.0
Windows NT 4.0
servers and
workstations include
a messenger service
to alert you to printer
errors or let you know
when a print job is
finished. If you have
appropriate network
access privileges or
you’re controlling
printing from the
server, you can also
set other options. See
your Windows NT
documentation for
details.

Managing Print Jobs

Your printer software offers three ways to manage and monitor your
print jobs:
◗

Progress Meter, which appears each time you send a print job,
as described in Checking Printer Status. You can turn the
Progress Meter on or off and select other printing options using
the Speed & Progress button; see Selecting the Speed &
Progress Options for details.

◗

Spool Manager (not available with Windows NT), which
appears in the taskbar at the bottom of the screen each time
you print, as described in Using the Spool Manager.

◗

Status Monitor 2, which provides a variety of print monitoring
options, as described in Using Status Monitor 2.
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Selecting the Speed & Progress Options
You can set up the way your printer software sends print jobs and
displays the Progress Meter using the Speed and Progress dialog
box. To access the dialog box, you must open your printer software
from the Windows Printers utility as described below.
1

Click Start, point to Settings, then click Printers.

2

Right-click the EPSON Stylus COLOR 740 printer icon and
select Properties (Windows 95 and 98) or Document Defaults
(Windows NT) from the menu.

3

Click the Utility tab. You see the Utility menu:
Utility tab

Speed &
Progress
button

4
Managing Print Jobs

Click the Speed & Progress button.
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You see this dialog box:

Not available with
Windows NT
If you have more than
one hard disk drive,
you can select a folder
for storing multiple
copy print jobs here.
You don’t see this box
if you have only one
hard disk drive.

Select the following options:

Managing Print Jobs

◗

High Speed Copies speeds up printing of multiple copies
of the same document using hard disk space as a cache.

◗

Show Progress Meter lets you control whether or not the
Progress Meter is displayed when you send a print job. See
Checking Printer Status for information on the Progress
Meter.
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◗

EPSON Printer Port (not available with Windows NT 4.0)
lets you optimize the transfer rate of your printer port for
EPSON printers instead of using the Windows default
printer port. You may see one of these messages beneath
the EPSON Printer Port option:
◗ High speed (DMA) transfer enabled tells you that
you’re already using fast DMA transfer mode.
◗ For higher data transfer rates, use DMA transfer lets
you know that you can speed up printing by enabling
DMA transfers on your system. See your computer
documentation or contact your computer’s technical
support for instructions on using DMA transfers, if your
computer supports them.
If you see no message, you cannot enable DMA transfers
on your system.

5

Managing Print Jobs

Click OK to close the Speed & Progress dialog box and return
to the Utility menu. Then click OK again to exit your printer
software.
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Using the Spool Manager
The Spool Manager (not available with Windows NT) creates a
temporary print job file and stores it in the C:\TEMP or
C:\WINDOWS\TEMP folder. The software then sends the file to
your printer at the right time.
To open Spool Manager while you’re printing, click the EPSON
Stylus COLOR 740 button that appears on the taskbar at the
bottom of the screen. You see the Spool Manager window:

Print job file

Command buttons

The Spool Manager window displays the status of your print job
files and lets you control them. To cancel, pause, resume, or restart
a print job, click the job to highlight it; then click the corresponding
command button on the bottom of the window.

Managing Print Jobs
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Deleting a Stalled Print Job
If you’re having trouble printing, it may be because of a stalled print
job. Follow these steps to delete it and continue printing:
1

Click the EPSON Stylus COLOR 740 button on the taskbar.

2

Click on any print jobs marked Held.

3

Click the Cancel button.

4

Exit Spool Manager and try printing again.

Using Status Monitor 2

Note:
You can check printer
status using Status
Monitor 2 only when
your printer is
connected directly to
your computer on a
bidirectional port.

Managing Print Jobs

Status Monitor 2 lets you view detailed information about your print
jobs and control how you want printing monitored. Before you can
use Status Monitor 2, you must enable background monitoring for
your printer if it isn’t already enabled.
Follow the instructions in these sections:
◗

Enabling Background Monitoring

◗

Setting Up Monitoring Preferences

◗

Using the Status Monitor 2 Main Window

◗

Using the Printer Status Window

◗

Using the Job Status Window
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Enabling Background Monitoring
To turn on background monitoring, follow these steps:
1

Click Start, point to Programs, click the Epson folder, and
click EPSON Status Monitor 2.

2

Click EPSON Stylus COLOR 740 in the Printer Name list. The
name is highlighted.

3

Open the Settings menu and select Background Monitoring.

4

Select either Monitor from restart (to begin background
monitoring after your next system restart) or Monitor now (to
begin background monitoring right away).

5

Now set your monitoring preferences for the printer as
described in Setting Up Monitoring Preferences.

Setting Up Monitoring Preferences
Note:
Background
monitoring must be
turned on to change
the Background
Monitoring and Status
Alert preferences.
See Enabling
Background
Monitoring for
instructions.
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You can select the way you want Status Monitor 2 to monitor your
printer using the Monitoring Preferences window. There are several
ways to open the window:
◗

Click the printer name in the Installed Printers list to highlight it
and click the
icon or select Monitoring Preferences from
the Settings menu.

◗

Right-click the printer name in the Installed Printers list and
select Monitoring Preferences from the drop-down menu.
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You see the Monitoring Preferences window:
Set the length of the interval in
which you want Status Monitor 2
to monitor your printer here
(short intervals may cause some
applications to run slower)
Turn background
monitoring on or off
for the selected
printer

Select if and when to use
the Status Alert dialog
box: while printing, when
errors occur, and/or when
ink is low

If you turn on one or more of the Status Alert options, you’ll see the
Status Alert dialog box when the selected condition occurs. For
example, if you turn on Show when errors occur, the dialog box
appears only if a printing error occurs. If you select all the options,
the dialog box appears whenever you print, encounter an error, or
have low ink levels.
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The color of the printer icon in the Status Alert dialog box indicates
the type of error, as described in Interpreting the Installed Printer
icon.

Click the printer name to
highlight it, then click
Details to open the Printer
Status window; see Using
the Printer Status Window
for more information
Click here to close the
Status Alert dialog box

Using the Status Monitor 2 Main Window
Once you’ve enabled background monitoring for your printer and
set up your monitoring preferences, there are two ways to access
Status Monitor 2:
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◗

Double-click the
icon on the taskbar in the bottom right
corner of your screen.

◗

Click Start, point to Programs, click the Epson folder, and
click EPSON Status Monitor 2.

Page 104

When you start Status Monitor 2, you see the main window:
Menu bar
Button bar
Installed
Printer icon
and name

Printer Name, Status,
and Job Count title bars
The number of print
jobs waiting to print
appears here
Brief status
messages appear
here

You can change the
shape of the Status
Monitor 2 printer icon
by clicking the Select
background
monitoring icon in
the Settings menu
and selecting the icon
you want to use.
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If you have more than one printer you want to monitor, you can add
them using the Add Printers option in the Settings menu. To save
system resources, you may want to delete any printers from the
Status Monitor 2 list that you don’t need to monitor. To do this, click
the printer in the Installed Printers list and select Delete Printer
from the Settings menu.
You can customize the appearance of items on the Status
Monitor 2 main window using the View menu options or using icons
on the button bar. If you’re monitoring multiple printers, you can
reorder them in the Installed Printers list by clicking in the Printer
Name, Status, or Job Count title bar.
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Other options in Status Monitor 2 let you view more details on the
printer or job status, as described in Using the Printer Status
Window and Using the Job Status Window.
Interpreting the Installed Printer icon
The color of the Installed Printer icon indicates the printer status as
follows:
Installed Printer
icon color

Status message

Green

Ready to print

Yellow

Paper and/or ink level is low

Red

Paper and/or ink is out, paper is jammed, or a print
error has occurred

Gray or dimmed

A communication error has occurred (check your
cable connections)

Using the Printer Status Window
For more details on the status of your printer, you can use the
Printer Status window. There are several ways to open the window:
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◗

Double-click the printer name in the Installed Printers list.

◗

Click the printer name in the Installed Printers list to highlight it
and click the
icon or select Printer Status from the Printer
menu.
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◗

Right-click the printer name in the Installed Printers list and
select Printer Status from the drop-down menu.

◗

If you’re currently using the printer software, click the Utility
tab, then click the EPSON Status Monitor 2 icon.

◗

You can also access the Printer Status window by clicking the
Details button on the Progress Meter (see Checking Printer
Status) or the Status Alert dialog box (see Setting Up
Monitoring Preferences).

You see the Printer Status window. The Current Status tab gives
printing status and error correction information.
Illustrations of what to do if an
error occurs appear here

If your printer runs out of ink,
click this button to display
cartridge replacement steps
on the right and illustrations in
the printer graphic area
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Printer status
messages
If an error occurs,
troubleshooting tips
appear here

Page 107

The printer graphic in the Printer Status window gives status and
error condition information:
Graphic

Condition
Ready to print

Paper isn’t loaded correctly

Paper is jammed

Black ink is out

Color ink is out

A communication error has occurred

Another type of printer error has occurred
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To check the amount of ink you have, click the Consumables tab.

These graphics indicate the
amount of ink remaining in
your cartridges

(The Printer Information tab doesn’t display information for your
printer.)

Using the Job Status Window

Note:
The Job Status
window is very similar
to the Spool Manager
window. Both allow
you to pause, cancel,
and restart print jobs.
See Using the Spool
Manager for more
information.
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To view detailed information on the print jobs waiting to print, you
can use the Job Status window (not available with Windows NT).
There are several ways to open the window:
◗

Click the printer name in the Installed Printers list to highlight it
and click the
icon or select Job Status from the Printer
menu.

◗

Right-click the printer name in the Installed Printers list and
select Job Status from the drop-down menu.
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You see the Job Status window:
Menu
bar

Information on jobs currently printing or waiting to be
printed appears here

Options in the Printer menu let you pause printing or purge all
waiting print jobs, select or deselect the printer as your Windows
default, and access the printer software to change default settings.
The Document menu options let you pause or cancel printing of
individual print jobs. First click the print job you want to pause or
cancel in the Document Name list to highlight it.
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Managing Print Jobs in Windows 3.1
Your Windows printer software includes two management utilities:
the Spool Manager and Despooler.
◗

The Spool Manager starts automatically when you send a job to
the printer. It allows you to print in the background while you
continue to work on your computer and to hold jobs to print at a
later time. If you’re using your printer on a network, it also
handles multiple print jobs that come in at the same time. See
the next section for details.

◗

The Despooler also starts automatically when you send a job to
the printer. It displays on your screen to provide printer status
information. See Checking Printer Status for details on the
Despooler.

Using the Spool Manager
The Spool Manager works like the Windows Print Manager. When
you send a job to your printer, your printer software creates a
temporary print job file, stores it in the C:\TEMP or
C:\WINDOWS\TEMP directory, and assigns it to a print queue. The
software then sends the file to your printer at the right time.
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To open Spool Manager, do one of the following:

Note:
You may not see the
Spool Manager icon if
Program Manager or
the current window is
maximized. Reduce
the window size to
see the Spool
Manager icon.

◗

To open it while you’re printing, click the EPSON Spool
Manager icon at the bottom of your desktop.

◗

You can open Spool Manager at any time by double-clicking
the Spool Manager4 icon in the EPSON program group.

You see the Spool Manager window:

Queue

Print job file

The Spool Manager window displays the status of your print job
files and lets you control them. You can also control print queues,
display of the Despooler, and the default spool directory. Click Help
in the Spool Manager menu bar for detailed information.
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Deleting a Stalled Print Job
If you’re having trouble printing, it may be because of a stalled print
job. Follow these steps to delete it and continue printing:
1

Open the Spool Manager as described in Using the Spool
Manager.

2

Click on any print jobs marked Held.

3

Open the Document menu and click Delete. Then click Yes.

4

Exit Spool Manager and try printing again.

Changing the Default Spool Directory
If you get an error message while printing, or printing is very slow,
you can try changing your default spool directory.
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1

Make a directory on your hard drive where you want Spool
Manager to store print job files, for example, C:\SPLTEMP.

2

Open the Spool Manager as described in Using the Spool
Manager.

3

Make sure EPSON Stylus COLOR 740 is selected, and then
choose Setup from the Queue menu. The Queue Setup dialog
box appears.

4

Change the spool directory to the one you created in step 1.
Also make sure Use Print Manager for this port is checked.
Then click OK.
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5

Choose Default Spool Directory from the Options menu.

6

In the dialog box, change the spool directory to the one you
created in step 1. Then click OK.

7

Close Spool Manager.

Managing Print Jobs on a Macintosh
Note:
You can also select
background printing
options before you
print. See Setting Up
Background Printing
Options for more
information.
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Your Macintosh printer software includes two print job management
utilities: Monitor3 and Status Monitor. It also includes a
Configuration utility for setting up print monitoring options.
◗

If you’re using background printing, Monitor3 starts
automatically when you send a job to the printer. It handles
printing while you continue to work on your Macintosh, lets you
track documents that are waiting to be printed, and lets you set
priorities and print times for waiting print jobs.

◗

The Status Monitor alerts you to any problems that occur during
printing. You can also use it at any time to see how much ink
you have left.

◗

The Configuration utility lets you select how you want to be
notified of printer errors and where you want print job files
stored.
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Using Monitor3
The Monitor3 utility lets you continue to work on your Macintosh
while your document is printing (however, background printing is
slower and may also slow down your system). You can then open
the Monitor3 dialog box to check on your print jobs and cancel,
pause, or restart them.
To use this utility, you need to turn on background printing and
increase the memory allocation for Monitor3, as described in
Setting Up Monitor3.

Setting Up Monitor3
Note:
You can also turn on
background printing
while you’re using
your printer software;
see Setting Up
Background Printing
Options for
instructions.
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1

Open the Chooser from the Apple menu and select the SC 740
icon. Then select the port you’re using.

2

Under Background Printing, click On and close the Chooser.

3

To increase the memory allocation, select EPSON Monitor3 in
the Extensions folder in your System folder. Then choose Get
Info from the File menu and set the Memory Requirements to
2000 or 3000, depending on your system’s available RAM.
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Monitoring Print Jobs with Monitor3
While you’re printing, click the EPSON Monitor3 icon on the
Application menu at the right end of the menu bar. You see the
following dialog box:

Job currently
printing
Jobs queued
for printing
Click to set
priorities or print
times for waiting
print jobs

You can track the printer’s progress with the current job, or
double-click a job and use these command buttons:
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◗

click

to delete

◗

click

to restart

◗

click

to pause
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To set priorities for jobs waiting to print, click the job, then click the
Show details arrow at the bottom of the window.

Note:
If you see a stop sign
icon and the message
Print queue on hold
in the EPSON
Monitor3 dialog box,
select Start print
queue from the
Printer menu to
release the queue
and resume printing.

Priority list box
Settings selected
for the highlighted
print job

The Priority list becomes active. Click the arrow and select one of
the following settings:
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◗

Normal prints the job in the order it is received

◗

Urgent moves the job before any Normal priority jobs in the
print queue

◗

Hold holds the job in the print queue until you’re ready to
release it for printing by clicking the restart icon
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◗

Print Time opens the dialog box below so you can set a
specific print time; click OK after setting the day and time

Using the Macintosh Status Monitor
You can use the Status Monitor to check the level of ink in your
printer. Follow these steps:
1

Choose Page Setup or Print from the File menu in your
application. You see a printer settings dialog box.

2

Click the

Utility icon. You see the Utility menu:

For information
about these
utilities, see
Maintenance and
Transportation
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3

Click the EPSON StatusMonitor icon. The software checks the
amount of ink remaining in the printer and displays the Status
Monitor window:

Click to recheck the
ink level

4
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To recheck the ink level check, click the Update button. To
close the Status Monitor dialog box, click OK.
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Selecting Configuration Options
You can configure the way you want the printer to handle error and
warning messages, ink level checks, and temporary spool folders in
the Configuration Settings dialog box. Follow these steps:
1

Choose Page Setup or Print from the File menu in your
application. You see a printer settings dialog box.

2

Click the

3

Click the Configuration button. You see the Configuration
Settings dialog box:

Utility icon. You see the Utility menu.

Printing stops when
these messages appear
Printing continues when
these messages appear
Spooled print job files are
stored in these folders
Click here to check for
errors and/or the ink level
before printing
Click here to select the default settings
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4

5

Managing Print Jobs

Select the configuration options you want as follows:
◗

Error notification lets you select whether you want your
system to beep and display error message text or just
display text if your printer encounters an error.

◗

Warning lets you choose whether warning messages beep
and display text or display text only.

◗

Temporary Spool folder and Temporary High Speed
Copies folder let you select the folders on your hard disk
that store the temporary print job and high speed
multiple-copy print job files created when you send a job to
the printer. Click the Select button to change the folder from
the default folder shown.

◗

Click the Check for errors before starting to print
checkbox if you want your software to check for errors
before starting your print job.

◗

Click the Check the ink level before starting to print
checkbox if you want your software to check for a low ink
condition before starting your print job.

When you’re finishing changing your configuration options,
click OK to return to the Utility menu.
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Maintenance and
Transportation
It’s easy to keep your EPSON Stylus COLOR 740 printer working at
its best. Just follow the simple instructions in this chapter for:
◗

Replacing an Ink Cartridge

◗

Cleaning the Print Head

◗

Aligning the Print Head

◗

Cleaning the Printer

◗

Transporting the Printer
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Replacing an Ink Cartridge
When the B black or A color ink out light flashes, the indicated
cartridge is low on ink. This is a good time to make sure you have a
new cartridge. When the light stays on, the cartridge is empty and
you need to replace it.
Use these EPSON ink cartridges within six months of installing
them and before the expiration date on the package:
Caution:
To ensure good
results, use genuine
EPSON cartridges
and do not refill
them. Other products
may cause damage
to your printer not
covered by EPSON’s
warranty.

Black ink cartridge S020189
Color ink cartridge S020191
When you need new ink cartridges, contact your dealer or call
EPSON Accessories at (800) 873-7766 or visit our web site at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.
If you need to replace an ink cartridge before the lights flash
(because the ink is too old, for example) follow the instructions in
Replacing an Outdated Ink Cartridge.
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Removing and Installing Ink Cartridges
You can replace a cartridge when the B black or A color ink out
light is either flashing or on. (If you press the R cleaning button
when both ink out lights are off, the printer cleans the print heads,
as described in Cleaning the Print Head.)
Follow these steps to replace ink cartridges:
1

Remove the new ink cartridge from its packaging.

2

Remove only the yellow part of the tape seal on top as shown
below. Don’t pull off the blue portion or try to remove the
clear seal underneath the cartridge.
Remove the
yellow tape

Caution:
You must remove the
yellow tape from the
top of the cartridge or
you will permanently
damage it. Do not
remove the clear seal
from the bottom of
the cartridge; ink will
leak out.
To avoid damaging
the printer, never
move the print head
by hand.

Black cartridge

3
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Color cartridge

Make sure the printer is turned on and not printing, then open
the printer cover.
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4

Caution:
Don’t open the clamp
or remove a cartridge
except to replace it
with a new one. Once
you remove a
cartridge, you can’t
reuse it, even if it
contains ink.

Warning:
If ink gets on your
hands, wash them
thoroughly with soap
and water. If ink gets
into your eyes, flush
them immediately
with water.

Press the R cleaning button and hold it for about three
seconds until the print head moves left and the P power light
begins flashing.
(The print head returns to its home position if you don’t proceed
to step 5 within 60 seconds.)

5

Pull up the ink cartridge clamp. The cartridge rises up from its
holder.

6

Lift the cartridge out of the printer and dispose of it carefully.
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Caution:
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

7

Lower the new ink cartridge into its holder with the label facing
up and toward the back of the printer.

8

Press down the ink cartridge clamp until it locks in place.

9

If you need to replace the other ink cartridge, repeat the
preceding steps before going on to step 10.

10 Press the R cleaning button and close the printer cover.
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The printer moves the print head and begins charging the ink
delivery system. (Even if you don’t press the button, ink
charging begins 60 seconds after you close the clamp.)
The P power light flashes, and the printer makes various
sounds. Charging takes a couple minutes. When it’s finished,
the P power light stops flashing and stays on.
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Replacing an Outdated Ink Cartridge
If an ink cartridge is more than six months old, you may need to
replace it. How can you tell? You may notice that your printouts
don’t look as good as they used to. If print quality doesn’t improve
after cleaning and aligning the print head, you can replace one or
both cartridges.
Follow these steps to replace an ink cartridge before the B black or
A color ink out light is flashing or on:

Caution:
To avoid damaging
the printer, never
move the print head
by hand.
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

1

Prepare your new ink cartridge for installation as described in
Removing and Installing Ink Cartridges.

2

Make sure the printer is turned on and not printing, then open
the printer cover.

3

Press the E load/eject button and hold it down for three
seconds until the print head moves to the left. The P power
light begins flashing.

4

Remove the old ink cartridge and install the new cartridge as
described in Removing and Installing Ink Cartridges. Don’t
press any control panel buttons, however.

5

Press the E load/eject button and close the printer cover.
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The printer moves the print head and begins charging the ink
delivery system. The P power light flashes and the printer
makes various sounds. Charging takes a couple minutes.
When it’s finished, the P power light stops flashing and stays
on.
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Cleaning the Print Head
If your printed image is unexpectedly light or faint, or dots are
missing from the image, you may need to clean the print head. This
unclogs the nozzles so they can deliver ink properly.
Cleaning the print head uses ink, so clean it only if print quality
declines. You can clean the print head in either of the following
ways:
◗

With the Head Cleaning utility in your printer software (when
connected to a local port, not over a network)

◗

Using the printer’s control panel buttons

Using the Head Cleaning Utility
Follow these steps to run the Head Cleaning utility:
1

Make sure the printer is turned on but not printing, and the
B black and A color ink out lights are off.

2

Start an application and open a document.

3

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

4

Click the Utility tab (Windows) or the
(Macintosh). You see the Utility menu.

5

Click the Head Cleaning icon.

Maintenance and Transportation

Utility icon
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6

Caution:
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

Follow the instructions on the screen to clean the print head.
Cleaning takes a couple minutes, during which the printer
makes some noise and the P power light flashes.
When the P power light stops flashing, run a nozzle check to
test the results and reset the cleaning cycle.

7

Make sure paper is loaded in the printer and click Print nozzle
check pattern (Windows) or Confirmation (Macintosh). Then
click Next. The nozzle check pattern prints on your printer; see
Examining the Nozzle Check Pattern for details.

8

If the nozzle check pattern is complete, click Finish.
If the pattern is missing dots, click Clean to run another
cleaning cycle. If you don’t see any improvement after cleaning
two or three times, check the print quality solutions in Improving
Print Quality.

Using the Control Panel
Follow these steps to clean the print head:
1

Make sure the printer is turned on and not printing, and that the
B black and A color ink out lights are off.

2

Press the R cleaning button and hold it down for three
seconds. Cleaning takes a couple minutes, during which the
printer makes some noise and the P power light flashes.
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3

After the P power light stops flashing, print a page to test the
print quality and reset the cleaning cycle.
If you’re connected directly to the printer, run a nozzle check.
Go to step 4.

Caution:
Never turn off the
printer while the
P power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

If you’re using DOS or printing over a network, open an
application and print a document containing black and color
data. Then go to step 8.
4

Start an application, open a document, and access the printer
settings dialog box as described in Printing from Windows or
Printing from a Macintosh.

5

Click the Utility tab (Windows) or the
(Macintosh). You see the Utility menu.

6

Make sure paper is loaded in the printer and click the Nozzle
Check icon, then click Next. The nozzle check pattern prints on
your printer; see Examining the Nozzle Check Pattern for
details.

7

If the nozzle check pattern is complete, click Finish.

Utility icon

If the pattern is missing dots, click Clean to run another
cleaning cycle.
8
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If you don’t see any improvement after cleaning two or three
times, check the print quality solutions in Troubleshooting.
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Examining the Nozzle Check Pattern
Examine the nozzle check pattern you print. It should look
something like this, with the lower pattern colored magenta, cyan,
and yellow:

Each staggered horizontal and straight vertical line should be
complete, with no gaps in the dot pattern. If your printout looks
okay, you’re done. If any dots are missing, as shown below, clean
the print head again; see Cleaning the Print Head for instructions.
Missing dots
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Aligning the Print Head

Caution:
Load paper that’s at
least 8.27 inches
(210 mm) wide. This
prevents ink from
spraying inside the
printer and smudging
your printouts.
For the best results,
load EPSON ink jet
paper in the printer
whenever you check
the print head
alignment.

If your printouts contain misaligned vertical lines, you may need to
align the print head using the Print Head Alignment utility in your
printer software. Your printer must be connected to a local port, not
on a network, to use this utility. Follow these steps:
1

Make sure the printer is turned on and paper is loaded.

2

Start an application and open a document.

3

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

4

Click the Utility tab (Windows) or the Utility icon (Macintosh).
You see the
Utility menu.

5

Click the Print Head Alignment icon.

6

Follow the instructions on the screen to print a test page and
select the correct alignment.
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Cleaning the Printer
To keep your printer working at its best, you should clean it several
times a year, following these steps:
Caution:
Don’t touch the gears
inside the printer.
Never use alcohol or
thinner for cleaning;
they can damage the
printer components
and case.

1

Turn off the printer, unplug the power cord, and disconnect the
printer cable.

2

Remove all the paper from the sheet feeder.

3

Clean the exterior of the printer with a soft, damp cloth.

4

Clean ink out of the printer’s interior with a soft, damp cloth.

Don’t use a hard or
abrasive brush.
Don’t get water on the
printer components.
Don’t spray lubricants
or oils inside the
printer.
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Transporting the Printer
If you move your printer some distance, you need to prepare it for
transportation in its original box. Follow these steps:

Caution:
To avoid damage,
always leave the ink
cartridges installed
when transporting
the printer.

1

Turn on the printer and wait until the print head locks in the far
right position. Then turn off the printer.

2

Unplug the power cord from the electrical outlet. Then
disconnect the interface cable from the printer.

3

Remove any paper from the printer and remove the paper
support.

4

Push in the output tray extensions and close the tray.

5

Repack the printer and attachments in the original box using
the protective materials that came with it. See the Unpacking
Sheet that was packed with your printer.

Be sure to keep the printer level as you transport it. If you notice a
decline in print quality after transporting the printer, clean the print
head (see Cleaning the Print Head); if output is misaligned, align
the print head (see Aligning the Print Head).
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Troubleshooting
As you use your printer, you may occasionally experience a paper
jam or other problem. The first thing you should do is diagnose the
problem, following the guidelines in this chapter. Then try the most
likely solutions until the problem is fixed.
This chapter covers the following problems and solutions:
◗

Diagnosing Problems

◗

Improving Print Quality

◗

Solving Printing Problems

◗

Solving Printer Software Problems

◗

Fixing Paper Problems

◗

Solving Miscellaneous Printout Problems

◗

Uninstalling Printer Software

◗

Where To Get Help
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Diagnosing Problems
There are a number of ways to diagnose printer problems:

Troubleshooting

◗

To identify the most common problems, check the printer’s
lights; see Checking the Control Panel Lights for details.

◗

You can also view the Printer Status window to identify
common problems, if you installed Status Monitor 2 with
Windows 95, 98, or NT 4.0. For instructions, see Using the
Printer Status Window. On a Macintosh, you can check your ink
levels using the Status Monitor; see Using the Macintosh
Status Monitor for details.

◗

To determine whether the problem is caused by the printer
itself, run a printer operation check. See Running a Printer
Operation Check for instructions.

◗

If you see an error message about your printer settings or have
problems with color quality, you may need to confirm your
Printer ID number. See Confirming the Printer ID Number for
details.

◗

For the latest information, check the Help programs and the
ReadMe files in the EPSON program group or folder.

◗

If any of the suggested solutions in this chapter tell you to
uninstall and then reinstall your printer software, see
Uninstalling Printer Software for instructions.

◗

If none of the suggested solutions here solve your problem,
contact your EPSON dealer or see Where To Get Help.
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Checking the Control Panel Lights
power
button

power
light

paper out light
black ink out light
color ink out light
cleaning button

load/eject button

Follow these guidelines when the control panel lights come on or
flash:

Troubleshooting

S

When the S paper out light flashes, paper is jammed
in the printer. Turn off the printer, remove all the paper
(including any pieces torn off inside), then reload the
stack. Turn on the printer and press the E load/eject
button. For tips on avoiding paper jams, see Paper
jams inside the printer.

S

When the S paper out light comes on, your paper ran
out or is incorrectly loaded. Load paper in the feeder
and then press the E load/eject button.

B or A

When an ink out light flashes, your ink supply is low.
Make sure you have a replacement cartridge.
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B or A

When an ink out light comes on, you need to replace
the ink cartridge. See Replacing an Ink Cartridge for
instructions.

P S B A When the P power and S paper out lights flash and

the B black and A color ink out lights come on,
jammed paper may be blocking movement of the print
head. See The P power and S paper out lights are
flashing and the B black and A color ink out lights are
on for more information.

P S B A When all the lights flash, your printer may have an
internal error. See All the lights are flashing for more
information.

Running a Printer Operation Check
You can run a printer operation check to determine whether the
problem comes from the printer itself or some other source.
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◗

If the results are satisfactory, the problem lies in your software
settings, the interface cable, or your computer.

◗

If the check page does not print correctly, you have a problem
with your printer. See the suggestions in this chapter for
possible solutions.

1

Make sure both the printer and computer are turned off.

2

Disconnect the interface cable from the printer.
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Caution:
Load paper that’s at
least 8.27 inches
(210 mm) wide. This
prevents ink from
spraying inside the
printer and smudging
your printouts.

3

Make sure paper is loaded in the printer.

4

Hold down the E load/eject button and press the P power
button. Hold down the E load/eject button until the P power light
starts to flash, then release it.
The printer prints its ROM version number and a nozzle check
pattern (shown in Examining the Nozzle Check Pattern).

5

To end the check, turn off the printer. Then reconnect the
interface cable and turn on your printer and computer.

Confirming the Printer ID Number
If you’re using Windows 95, Windows 98, or Windows NT, you can
use the Printer and Option Information utility to confirm the Printer
ID. Color quality may improve after you confirm the ID number.
If you’re using Status Monitor 2, this information is updated
automatically. However, if a message appears prompting you to
enter settings or if you change the printer’s configuration, you’ll
need to update the Printer ID manually. Follow these steps:
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1

Make sure letter-size paper is loaded in your printer.

2

Access the main printer settings dialog box as described in
Printing from Windows.

3

Click the Utility tab. Then click the Printer and Option
Information icon.
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4

Click the Settings Sheet button. The printer prints the Printer
ID on a sheet of paper.

5

Make sure the Printer ID shown in the Printer and Option
Information dialog box matches the ID on the Settings Sheet. If
they don’t match, change the ID numbers in the dialog box to
match those on the Settings Sheet.

6

Click OK to exit and save your settings.

Improving Print Quality
If you find that your print quality has declined, you can often
improve it by doing one of the following:
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◗

Clean the print head following the instructions in Cleaning the
Print Head.

◗

Use higher quality paper appropriate for your print job. See
Selecting Special Media for a list of EPSON papers.

◗

Match the Media Type in the printer software to the type of
paper you loaded in the printer. Then the printer software can
automatically select other settings for the best quality. (See
Basic Printing and Selecting Special Media for details.)

◗

Turn off High Speed mode in the Advanced dialog box, as
described in Customizing Print Quality and Special Effects.
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◗

Make sure Economy mode is turned off in the printer software,
as described in Customizing Print Quality and Special Effects.

◗

Check the status of the B black and A color ink out lights, then
replace the ink cartridges, if necessary, as described in
Replacing an Ink Cartridge.

Here are some detailed solutions to print quality problems.

The printed image has horizontal banding
Possible cause

Solution

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows or Printing from a Macintosh for instructions.

The printable side of
the paper is face down.

Remove the paper and reload it with the printable side face up. See
Media Loading and Handling Guidelines for instructions.

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The MicroWeave
option is not turned on.

Turn on MicroWeave (if available) in the Advanced dialog box. See
Customizing Print Quality and Special Effects for more information.

The Maximum
Printable Area setting is
turned on.

Select the Standard Printable Area setting to avoid banding in the
expanded margin area. See Selecting Paper Size and Orientation
Options for more information.
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Vertical lines are misaligned or vertical banding appears
Possible cause

Solution

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The paper thickness
lever is in the +
position.

Set the paper thickness lever to the 0 position and try printing again. See
Envelopes for instructions.

The High Speed
setting is turned on.

Turn off the High Speed setting if vertical lines are misaligned. See
Customizing Print Quality and Special Effects for information.

The print head is
misaligned.

Run the Print Head Alignment utility. See Aligning the Print Head for
instructions.

The printed image has incorrect or missing colors
Possible cause

Solution

The Ink option is set to
Black.

Change the Ink setting to Color. See Printing from Windows or Printing
from a Macintosh for instructions.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows or Printing from a Macintosh for instructions.

The Halftoning and
Color Management
options are set
incorrectly for your
document type.

Use the correct settings for the project you’re printing, following the
instructions in Customizing Print Quality and Special Effects and
Customizing Color Settings.
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Possible cause

Solution

The printable side of
the paper is face
down.

Remove the paper and reload it with the printable side face up. See
Media Loading and Handling Guidelines for instructions.

The ICM (Windows 95
or Windows 98),
sRGB (Windows 95,
98, NT), or ColorSync
(Macintosh) settings
are incorrect for your
document.

Use the Automatic mode setting or choose a different Rendering
Intent setting (Macintosh). See Advanced Printing for more information.

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink or one or
more ink colors are
empty.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The colors displayed
on your monitor don’t
match the printed
colors.

Because your monitor and printer use different technologies to represent
colors, your printed colors can’t exactly match the colors you see on your
monitor screen. Use the ICM (Windows 95 or Windows 98), sRGB
(recommended for Windows 98 only), or ColorSync (Macintosh)
settings to get as close a match as possible. See Advanced Printing for
more information.

The color settings in
your application
software need
adjustment.

You may be able to adjust various color settings in your application
software. See your software documentation for more information.
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The printed image is faint or has gaps
Possible cause

Solution

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows or Printing from a Macintosh for instructions.

The loaded paper is
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

The ink cartridges are
low on ink.

Check the B black and A color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The printed image is blurry or smeared
Possible cause

Solution

The loaded paper is
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

The paper thickness
lever is in the wrong
position.

Set the paper thickness lever to the + position to print on envelopes or
other thick media; set the lever to the 0 position to print on other media
types. See Envelopes for instructions, then try printing again.

The paper is damp or
the printable side is
face down.

Remove the paper and reload a new stack with the printable side face
up. See Media Loading and Handling Guidelines for instructions.

You loaded special
media without a
support sheet.

Follow the special media loading instructions in Media Loading and
Handling Guidelines and on the paper packaging for media that require
support sheets. Also try loading your media one sheet at a time.
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Possible cause

Solution

You tried to print on
cardboard or other
non-recommended
media.

Make sure your paper or media meets the specifications listed in Paper.
If your printouts are still blurry after you change paper, clean the print
head as described in Cleaning the Print Head.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you’re using. See
Printing from Windows or Printing from a Macintosh for instructions.

Ink has leaked inside
the printer.

Clean carefully inside the printer to remove spilled ink. See Cleaning the
Printer for instructions.

You’re using the High
Speed and
MicroWeave settings
with a misaligned print
head.

Turn off High Speed following the instructions in Customizing Print
Quality and Special Effects. Then run the Print Head Alignment utility
following the instructions in Aligning the Print Head.

The resolution of your
image may be too low.

If a photographic image looks grainy or rough, try using the
PhotoEnhance3 (PhotoEnhance on Windows 3.1) and Sharpness
setting to improve the printed quality. See Customizing Color Settings for
details. You can also increase the image resolution using your
image-editing software, or decrease the size of the image.
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Solving Printing Problems
If the printer won’t print, first check that:
◗

The printer is turned on and the P power light is on, but not
flashing.

◗

Paper is loaded in the printer.

◗

The printer is plugged into a working electrical outlet that’s not
controlled by a switch or timer.

◗

The interface cable is securely connected to the printer and
computer.

If you still can’t print, check the following solutions.

All lights are off
Possible cause

Solution

The printer is not
receiving power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is not controlled by a switch or timer and
is operable.
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Only the P power light is on, but nothing prints
Possible cause

Solution

The interface cable is
not connected
securely.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets the printer’s specifications.

The printer has an
internal problem.

Turn off the printer and computer, disconnect the interface cable, and
run a printer check as described in Running a Printer Operation Check.

The printer or
application software is
installed incorrectly.

If the printer check works, make sure your printer and application
software are correctly installed. If you’re printing on a network, you may
need to set up your printer for network printing, as described in the
Printer Basics book.

Your computer doesn’t
have enough memory
to handle the file you’re
printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or monitor.
◗ Add more memory to your computer.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager; see Using
the Spool Manager for instructions. In Windows NT, uninstall the
EPSON Printer Port. Click Start, point to Programs, EPSON Printers,
and select EPSON Printer Port Uninstall.
On a Macintosh, delete stalled print jobs using Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and then delete any queued files.

The print head nozzles
are clogged or the ink
cartridges are too old.
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Clean the print head; see Cleaning the Print Head for instructions. If
cleaning doesn’t help, replace the cartridges. For information on
cartridge life and replacement instructions, see Replacing an Ink
Cartridge.
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The S paper out light is flashing or on
Possible cause

Solution

If flashing, paper is
jammed.

Remove the paper and follow the guidelines for preventing jams as
described in Paper jams inside the printer.

If on, paper is used up Load paper or remove the stack and reload it as described in the Start
or is loaded incorrectly. Here card and in Media Loading and Handling Guidelines. Then press
the E load/eject button to turn off the S paper out light and resume
printing.

A B black or A color ink out light is flashing or on
Possible cause

Solution

If flashing, the ink
supply is getting low.

You need to replace the indicated ink cartridge soon; see Replacing an
Ink Cartridge for instructions.

If on, the ink cartridge
is empty.

You must replace the indicated ink cartridge now to be able to print; see
Replacing an Ink Cartridge for instructions.

The P power and S paper out lights are flashing and the B black and A color ink out
lights are on
Possible cause

Solution

Jammed paper may be
blocking movement of
the print head.

Turn off the printer, wait a few seconds, and turn it back on to eject any
paper. If no paper is ejected, turn off the printer, remove the jammed
paper, and turn it on again. If the lights are still flashing and on, contact
your EPSON dealer or see Where To Get Help.
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All the lights are flashing
Possible cause

Solution

You haven’t removed
all the packing material
from the printer.

Remove the tape and other packing material following the instructions
on the Unpacking Sheet.

An internal error may
have occurred.

Turn off your printer, wait a few seconds, and turn it on again. If the
lights still flash or stay on, contact your EPSON dealer or see Where To
Get Help.

The printer has finished charging the ink cartridge, but the P power light is still
flashing
Possible cause

Solution

The ink cartridge
clamp isn’t locked
down.

Press down the clamp to lock it.

Packing material
remains in the printer.

Remove the tape and other packing material following the instructions on
the Unpacking Sheet.

The printer needs to
initialize.

If the printer is not moving or making noise, but the P power light is still
flashing after more than 5 minutes, turn the printer off. If the light is still
flashing when you turn it back on, contact your EPSON dealer or see
Where To Get Help.
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Solving Printer Software Problems
If you have trouble with your printer software, first check that your
printer is selected as the default Windows printer or as the current
printer in the Macintosh Chooser.
If you still have problems with your printer software, check the
following solutions.

The printer software installed with Windows 3.1 doesn’t work correctly after you
upgrade to Windows 95 or Windows 98
Possible cause

Solution

Your printer software is
not set up correctly for
the new operating
system.

Uninstall the printer software after installing Windows 95 or Windows 98,
as described in Uninstalling Printer Software. Then reinstall it as
described in the Start Here card.

When installing your printer software, you see the Windows New Hardware Found
window
Possible cause

Solution

Windows has detected
your printer.

If your printer is connected using a parallel connection, click Cancel.
Never select any other option on the New Hardware Found window.
If your printer is connected using a USB port, see the USB Software
Installation Guide for instructions on using Windows 98 plug-and-play.
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You see a spooling error message (Windows)
Possible cause

Solution

If you see error
messages or printing is
very slow, the problem
may be caused by
temporary files
(Windows 3.1 only).

Change the Spool Manager default directory (Windows 3.1 only),
following the instructions in Using the Spool Manager.

Your hard drive is too
full.

Delete unnecessary files to make room on the drive.

Your computer doesn’t
have enough memory
for the file you’re
printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or monitor.
◗ Add more memory to your computer.

You see a memory error message (Macintosh)
Possible cause

Solution

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.
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If that doesn’t work, turn off background printing in the Chooser or in your
printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.
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In Windows 95, Windows 98, or Windows NT, the Status Monitor 2 window
doesn’t appear
Possible cause

Solution

You didn’t restart your
computer after
installing Status
Monitor 2.

Click Start, select Shut Down, click Restart the computer, and click
Yes to restart your computer. Then try using Status Monitor 2.

Bi-directional support
is not enabled.

Click Start, select Settings, and click Printers. Right-click the EPSON
Stylus COLOR 740 icon and select Properties. Click the Details tab,
then click the Spool Settings button. Click the Enable bi-directional
support for this printer radio button to turn on bi-directional support.
Click OK twice, then close the Printers window and try printing again.

You’re using
ScanDisk.

Before using ScanDisk, turn off background monitoring in Status
Monitor 2. (See Enabling Background Monitoring for instructions.) Then
turn it back on when you’re finished using ScanDisk.
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Printing is too slow
Possible cause

Solution

Your printer software
options are set
incorrectly.

For the fastest printing, try the following printer software settings:
◗ Set Print Quality to Economy.
◗ Turn MicroWeave off.
◗ Turn High Speed on.
◗ Choose Black ink and No Halftoning.
See Advanced Printing for instructions.

Your system doesn’t
have enough
resources.

◗
◗
◗
◗

You’re using
background printing
on a Macintosh.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.

Clear space on your hard disk or run a defragmentation utility.
Don’t run too many applications at the same time.
Turn off virtual memory.
Increase your system’s memory (RAM) and/or processor speed.

If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.
You’re not using ECP
or Enhanced mode
and/or DMA transfers.

Troubleshooting

If your computer supports ECP or Enhanced mode and/or DMA
transfers, turn them on to speed up printing. See your computer
documentation for details.
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Your printer switches to the modem port or won’t confirm on the printer
port (Macintosh)
Possible cause

Solution

Your Macintosh has
extension conflicts.

Make sure AppleTalk® is inactive. In the Chooser, select any Apple serial
printer (such as the LaserWriter) and choose the printer port. Close the
Chooser, then reopen it and select the SC 740 icon and the printer port.
Then restart your system.

You’re using an
AppleTalk cable.

Make sure you’re using a standard Apple System Peripheral-8 cable.
See Macintosh System Requirements for more information.

Your printer icon doesn’t appear in the Chooser (Macintosh)
Possible cause

Solution

Your Macintosh has
extension conflicts.

Disable Quick Draw GX in the Extensions Manager. Make sure EPSON
Monitor3 and SC 740 are enabled, and then restart your Macintosh.

The Chooser contains
too many items.

Delete unused items or move them to the Extensions (Disabled) folder.
Then check for your printer icon in the Chooser again.

Your application program can’t open your image file (Macintosh)
Possible cause

Solution

Not enough memory
is allocated to the
application.

Highlight the program icon and select Get Info from the File menu, then
increase the memory allocated to the application.
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The “SC 740 cannot be used” message appears (Macintosh)
Possible cause

Solutions

The printer software
has been corrupted.

Remove and reinstall the printer software as described in Uninstalling
Printer Software. Then, in the Extensions Manager, disable Quick Draw
GX, enable EPSON Monitor3 and SC 740, and restart.

Your printer doesn’t print correctly as a remote printer (Windows NT)
Possible cause

Solution

You may need to use
a different network
path and printer port.

Select a different printer port in the printer’s Properties window and enter
the new network path to your printer at the DOS prompt. Then restart
your computer. See your Windows NT documentation for instructions on
changing the printer port and network path.

Fixing Paper Problems
To avoid most paper handling problems:
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◗

Use smooth, high-quality media designed for ink jet printers
that meets the media specifications in Paper.

◗

Follow all loading and handling instructions included with the
media.

◗

Load the media with the printable side face up as described in
the Start Here card and in Media Loading and Handling
Guidelines.
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If you have any paper problems, check here for solutions.

Paper doesn’t feed
Try this

Then do this

Remove the stack of
paper from the printer.

Check that the paper isn’t:
◗
◗
◗
◗

Curled or creased.
Too old. (See Media Loading and Handling Guidelines or your
paper packaging for more information.)
Loaded above the arrow on the left edge guide.
Jammed inside the printer. (If the S paper out light is flashing,
paper is jammed.)

Then reload the paper against the right edge guide as described in the
Start Here card and in Media Loading and Handling Guidelines,
adjusting the left edge guide to fit the paper’s width.

Multiple pages feed at the same time
Try this

Then do this

Remove the stack of
paper from the printer.

◗
◗
◗
◗

Troubleshooting

Make sure the paper isn’t too thin (see the specifications in Paper).
Fan all the edges of the stack of paper to separate the sheets.
Reload the paper as described in the Start Here card and in Media
Loading and Handling Guidelines.
If too many copies of a page or document are printing, check the
Copies settings in both the printer software and your application
program. See Selecting Paper Size and Orientation Options for
more information.
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Paper jams inside the printer
Try this

Then do this

Turn off your printer,
open the cover, and
remove all the paper
that’s inside, including
any little pieces that
may have torn off.

Load more paper in the printer, following the instructions in the Start
Here card and in Media Loading and Handling Guidelines. If your paper
jams frequently, make sure you:
◗
◗
◗
◗

Use smooth, high-quality paper, loaded printable side up.
Fan the stack and then even the edges before loading it.
Load paper beneath the arrow mark on the left edge guide.
Adjust the left edge guide to fit the width of your paper.

Paper doesn't eject fully or is wrinkled
Possible cause

Solution

If the paper doesn’t
eject fully, you may
have set the wrong
paper size.

Press the E load/eject button to eject the paper. Then make sure you
select the correct paper size in your printer software. See Selecting
Paper Size and Orientation Options for instructions.

If it’s wrinkled when it
comes out, the paper
may be damp or too
thin.

See the specifications in Paper for ranges of paper thicknesses you can
print with, as well as environmental requirements for storage.
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Solving Miscellaneous Printout Problems
If your printout results are not what you expected, try these
solutions.

Characters are incorrect or garbled
Possible cause

Solution

Your printer is not
selected in your
application or as the
Windows default
printer.

Select your printer in your application or select it as the default Windows
printer. See your Windows documentation or online help for
instructions.

Your printer is not
selected in the
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card or
in the USB Software Installation Guide.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager; see Using
the Spool Manager for instructions. In Windows NT, uninstall the
EPSON Printer Port. Click Start, point to Programs, EPSON Printers,
and select EPSON Printer Port Uninstall.
On a Macintosh, select the stalled print jobs in Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and delete any queued files.
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Possible cause

Solution

The interface cable
is not securely
connected.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets the printer’s specifications.

Your video driver may
be conflicting with the
EPSON printer driver.

Change to a standard VGA driver (see your computer or video card
documentation for instructions). If your printout is correct, your video
driver is interfering with the printer driver. Contact your computer or
video card manufacturer for an updated driver.

The image is inverted as if viewed in a mirror
Possible cause

Solution

You used a Flip
Horizontal option.

Turn off the Flip Horizontal or mirror setting in your application software
or the printer software. See Customizing Print Quality and Special
Effects for instructions.

The image size or position is incorrect
Possible cause

Solution

The paper and/or
layout options are set
incorrectly.

Check the paper settings and the settings on the Layout dialog box
(Windows 95, 98, and NT, or Macintosh only). See Selecting Print
Layout Options for instructions. Also check the paper and layout options
in your application software.
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The margins are incorrect
Possible cause

Solution

Margins are set
incorrectly in your
application software.

Check your software documentation for instructions on selecting the
correct margins for your paper size and within its printable area. See
Printable area for more information.

Paper settings in the
printer software are
incorrect for your paper
size.

Check the paper size, orientation, printable area, and layout settings to
make sure they’re correct for your paper size. See Selecting Paper Size
and Orientation Options and Selecting Print Layout Options for more
information.

A portion of your image doesn’t print (Macintosh)
Possible cause

Solution

Your system doesn’t
have enough available
memory.

Close any other applications you are running and turn off background
printing as described in Setting Up Background Printing Options.

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.
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If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.
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The printer prints blank pages
Possible cause

Solution

Your printer is not
selected in your
application or as the
Windows default
printer.

Select your printer in your application or select it as the default Windows
printer. See your Windows documentation or online help for instructions.

Your printer is not
selected in the
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card or
in the USB Software Installation Guide.

Paper settings in the
printer software are
incorrect for your
paper size.

Check the paper size, orientation, printable area, and layout settings to
make sure they’re correct for your paper size. See Selecting Paper Size
and Orientation Options and Selecting Print Layout Options for more
information.

The print head nozzles
are clogged.

Clean the print head following the instructions in Cleaning the Print
Head.
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Uninstalling Printer Software
If you need to uninstall and reinstall your printer software, follow the
steps in the section for your operating system:

Caution:
If you uninstall and
then reinstall the
printer software in
Windows 95, 98, or
NT 4.0, you must also
uninstall and then
reinstall Status
Monitor 2 so it can
recognize your
printer.
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◗

Windows 95, Windows 98, and Windows NT 4.0 Instructions

◗

Windows 3.1 Instructions

◗

Macintosh Instructions

Windows 95, Windows 98, and Windows NT 4.0
Instructions
1

Double-click the My Computer icon, then double-click the
Control Panel icon.

2

Double-click Add/Remove Programs.

3

To uninstall the printer software, select EPSON Printer
Software in the program list.

4

Click the Add/Remove button. Follow the instructions on the
screen to uninstall your software.

5

Before you uninstall Status Monitor 2, turn off background
monitoring as described in Enabling Background Monitoring.
Then follow steps 3 and 4 again. In step 3, select EPSON
Status Monitor 2 in the program list to uninstall it.
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6

If you’re using Windows 98 with a USB connection, you need to
uninstall the EPSON USB Printer Device software also. Follow
steps 3 and 4 again. In step 3, select EPSON USB Printer
Devices in the list.

7

Restart your computer. To reinstall your software, see the Start
Here card or the USB Software Installation Guide.

Windows 3.1 Instructions
1

Double-click the Main program group icon, then double-click
the Control Panel icon.

2

Double-click Printers.

3

Select EPSON Stylus COLOR 740 in the Installed Printers list
and click the Remove button.

4

To reinstall your software, see the Start Here card.

Macintosh Instructions

Troubleshooting

1

Insert the EPSON printer software CD-ROM in your drive.

2

Double-click the EPSON icon. After a moment, you see the
EPSON Stylus COLOR 740 Installer Main Menu.

3

Click Re-install Printer Driver, then click the same button on
the next screen.

4

At the driver installation title screen, click Continue.
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Troubleshooting

5

Click the arrow in the list at the top showing Easy Install, and
select Remove from the list.

6

Click the Remove button on the bottom of the screen.

7

Follow the instructions on the screen to uninstall the printer
software. Then restart your Macintosh.

8

To reinstall your software, see the Start Here card or the USB
Software Installation Guide.

Page 164

Where To Get Help
EPSON provides technical assistance through electronic support
services and automated telephone services 24 hours a day. The
following tables list the contact information:
Electronic support services
Service

Access

World Wide Web

From the Internet, you can reach EPSON’s Home Page at
http://www.epson.com.

EPSON Internet FTP Site

If you have Internet FTP capability, use your Web browser
(or other software for FTP downloading) to log onto
ftp.epson.com with the user name anonymous and your
e-mail address as the password.

EPSON Forum on CompuServe®

Members of CompuServe can type GO EPSON at the menu
prompt to reach the Epson America Forum. For a free
introductory CompuServe membership, call (800) 848-8199
and ask for representative #529.

Troubleshooting
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Automated telephone services
Service

Access

EPSON SoundAdviceSM

For pre-recorded answers to commonly asked questions
about EPSON products 24 hours a day, seven days a week,
call (800) 922-8911.

EPSON FaxAdvice™

Access EPSON’s technical information library by calling
(800) 922-8911. You must provide a return fax number to
use this service.

EPSON Referral Service

For the location of your nearest Authorized EPSON Reseller
or Customer Care Center, call (800) 922-8911.

To speak to a technical support representative, dial (310) 974-1188
(U.S.) or (905) 709-2567 (Canada), 6 AM to 8 PM, Pacific Time,
Monday through Friday and 7 AM to 4 PM, Saturday. Toll or long
distance charges may apply.
Before you call, please have the following information ready:
Note:
If you need help
using another
manufacturer’s
software with an
EPSON product, see
the documentation
for that software for
technical support
information.

Troubleshooting

◗

Product name (EPSON Stylus COLOR 740)

◗

Product serial number (located on the back of the printer)

◗

Computer configuration

◗

Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories
from EPSON Accessories at (800) 873-7766 or visit our web site at
www.epsonsupplies.com (U.S. sales only). In Canada, please call
(800) 873-7766 for dealer referral.
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Specifications
Printing
Printing method

On-demand ink jet

Nozzle configuration

144 black nozzles
144 color nozzles (48 cyan, 48 magenta, 48 yellow)

Resolution

Maximum 1440 × 720 dpi

Input buffer

64KB

Print direction

Bidirectional with logic seeking

Control code

ESC/P 2™ and raster graphics code and EPSON Remote

Character tables

1 italic and 10 graphics character tables

Character sets

14 international character sets and 1 legal character set

Bitmap fonts

◗
◗
◗
◗
◗

EPSON Roman (proportional)
EPSON Sans Serif (proportional)
EPSON Courier
EPSON Prestige
EPSON Script

All bitmap fonts are available in 10, 12, and 15 cpi. You can select other font/pitch
combinations using ESC/P 2 commands.
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◗
◗
◗
◗

Scalable fonts

EPSON Roman
EPSON Sans Serif
EPSON Roman T
EPSON Sans Serif H

All scalable fonts are available in sizes from 8 to 32 points, in 2 point increments,
and four styles: normal, bold, italic, and bold italic.
The printer always uses the fonts you select with your software application. You
need to use the printer’s internal fonts only if your application doesn’t allow you to
select fonts.

Paper
Paper type

Size

Paper types

Thickness

Weight

Single sheets

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches)
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and
special ink jet
papers
distributed by
EPSON

0.003 to 0.004 inch
(0.08 to 0.11 mm)

17 to 24 lb
(64 to 90 g/m2)

Transparencies
and glossy
media

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy film
only)

Transparencies,
glossy paper,
and glossy film
distributed by
EPSON

—

—

Specifications
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Photo Paper

Photo Paper
4 × 6 inches (102 × 152 mm)
distributed by
Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
EPSON
Panoramic (8.27 × 23.4 inches)

—

—

Photo stickers

A6 (105 × 148 mm)
with 16 frames

Photo stickers
distributed by
EPSON

—

—

Self adhesive
sheets and
iron-on cool peel
transfer paper

A4 (210 × 297 mm)
Letter (8.5 × 11 inches; cool
peel transfer paper only)

Self adhesive
sheets and
iron-on cool peel
transfer paper
distributed by
EPSON

—

—

Envelopes

#10 9.5 × 4.1 inches
(240 × 104 mm)
DL 8.7 × 4.3 inches
(220 × 110 mm)
C6 4.4 × 6.4 inches
(114 × 162 mm)
Note card envelope
5.2 × 8.7 inches
(132 × 220 mm)

Plain, bond, or
air mail paper

0.006 to 0.02 inch
(0.16 to 0.52 mm)

12 to 20 lb
(45 to 75 g/m2)

Ink Jet cards

A6 (105 × 148 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards
distributed by
EPSON

—

—
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Note:
Print only under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity:
40 to 60% RH
Store glossy film and self adhesive sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity:
20 to 60% RH
Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, EPSON cannot guarantee the use af any particular brand or type of paper. Always test
samples of paper stock before purchasing large quantities or printing
large jobs.
Poor quality paper may reduce print quality and cause paper jams and other problems. If you
encounter problems, switch to a higher grade of paper. Do not load curled or folded paper,
envelopes, or transparencies.

Specifications
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Printable area
A
A

B-L
B-R

B-R
C

B-L
Envelopes

C
Single sheets and cards
B-L
A

Note:
Always load paper
into the sheet feeder
short edge first
except envelopes.
Load envelopes long
edge first.

Specifications

C
B-R

EPSON Panoramic
Photo Paper

A

The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of EPSON Photo Quality Glossy Film, the
minimum top margin is 1.2 inches (30 mm).

BL

The minimum left margin is 0.12 inch (3.0 mm).

BR

The minimum right margin is:
0.35 inch (9.0 mm) for Letter and Legal
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3.0 mm) for all other paper sizes.

C

The minimum bottom margin is 0.55 inch (14.0 mm) using the Standard
printable area setting. This can be decreased to 0.12 inch (3.0 mm)
using the Maximum printable area setting. However, the print quality in
the expanded printable area may be reduced.
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Ink Cartridges
Specification Black ink cartridge (S020189)

Color ink cartridge (S020191)

Color(s)

Black

Cyan, magenta, and yellow

Print
capacity*

900 pages text (ISO/IEC 10561 letter pattern) 300 pages (15% coverage)
300 pages graphic (5% coverage)

Cartridge life

2 years from production date and up to within 6 months after opening package at
77 °C (25 °F)

Storage
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit
temperature

–22 to 140 °C (–30 to 60 °F)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing
3.2 °F (–16 °C)
temperature**
Dimensions

1.09 (W) × 2.1 (D) × 1.5 (H) inches
27.8 (W) × 52.7 (D) × 38.5 (H) mm

–0.4 °F (–18 °C)
1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm

* The print capacity may vary depending on how often you clean the print head.
** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).
Caution:
To ensure good results, use genuine EPSON cartridges and do not refill them. Other products may
cause damage to your printer not covered by EPSON’s warranty.
Do not use an ink cartridge after the expiration date on the package.
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Mechanical
Paper feed method

Friction with auto sheet feeder, rear entry

Sheet feeder
capacity

Maximum 100 sheets of 17 lb (64 g/m2) paper

Dimensions
Storage

Width: 16.9 inches (429 mm)
Depth: 10.3 inches (261 mm)
Height: 6.6 inches (167 mm)

Printing

Width: 16.8 inches (429 mm)
Depth: 24.1 inches (613 mm)
Height: 12.2 inches (309 mm)

Weight

11.5 lb (5.2 kg) without the ink cartridges

Specifications
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Electrical
Specification

120V model

240V model*

Input voltage range

99V to 132V

198V to 264V

Rated frequency range

50 to 60 Hz

Input frequency range

49.5 to 60.5 Hz

Rated current

0.4A

Power consumption

Approx. 18 W (ISO 10561 Letter Pattern)
Approx. 5 W in standby mode

0.2A

* Also designed for IT power systems with Phase to Phase voltage
220–240V

Environmental
Temperature

Operation
Storage*
Transit*

Humidity

Operation
Storage*

50 to 95 °F (10 to 35 °C)
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
–4 to 140 °F (–20 to 60 °C)
120 hours at 140 °F (60 °C)
20 to 80% RH
5 to 85% RH (without condensation)

* Stored in shipping container

Specifications
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Safety Approvals
Safety standards

UL 1950, CSA 22.2 No. 950

EMC

FCC part 15 subpart B class B

DOS Support
If driver support for the EPSON Stylus COLOR 740 is not available
from your software manufacturer, you can use one of the other
EPSON ESC/P 2 printer drivers. These drivers don’t provide all the
EPSON Stylus COLOR 740 features, such as 720 or 1440 dpi
printing. Choose the first printer available from the following two
lists:
Black printing only

◗
◗
◗
◗
◗

LQ-870/1170
LQ-570(+)/1070(+)
SQ-870/1070
LQ-850
LQ-500

Color and black
printing

◗
◗
◗
◗
◗

EPSON Stylus PRO
EPSON Stylus COLOR 500
EPSON Stylus COLOR II
LQ-860
LQ-2550

Specifications
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Control Panel Settings
You can change the following default settings from the printer’s
control panel:

Changing control
panel settings

Specifications

Setting

Options

Font

Courier, Roman, Sans Serif, Prestige, Script,
Roman T, Sans Serif H, Draft

Character table

Italic U.S.A., Italic France, Italic Germany, Italic
U.K., Italic Denmark 1, Italic Sweden, Italic Italy,
Italic Spain 1, PC 437 (U.S./Standard Europe),
PC850 (Multilingual), PC860 (Portuguese), PC861
(Icelandic), PC863 (Canadian-French), PC865
(Nordic), Abicomp, BRASCII, Roman 8, ISO Latin 1

Follow these steps to change the settings listed above:
1

Make sure the printer is turned off and has paper loaded (at
least 8.27 inches [210 mm] wide).

2

Hold down the R cleaning button and press the P power
button. The printer prints a summary of instructions for
changing settings and choosing a language for the instructions.

3

Press the E load/eject button to print a list of current settings
(indicated with arrows) and additional instructions.

4

After you make the changes you want, turn the printer off to
save the settings. The settings remain in effect until you change
them again.
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Character Tables
All character tables except Italic are the same as the PC437 table
for hex codes 00 through 7F. Additional characters are available for
hex codes 80 through FF. You can select the following character
tables through the control panel or software commands:
◗
◗
◗
◗
◗
◗
◗
◗
◗
◗
◗

International
character sets

Specifications

PC437 (U.S./Standard Europe)
PC850 (Multilingual)
PC860 (Portuguese)
PC861 (Icelandic)
PC863 (Canadian-French)
PC865 (Nordic)
Abicomp
BRASCII
Roman 8
ISO Latin 1
Italic (no characters available for hex code 15)

You can select a number of international character sets with the
control panel or the ESC R command. Other sets can only be
selected with the ESC R command. You can select additional
characters with the ESC ( ^ command.

Page 177

Interfaces
Parallel interface

Forward channel
Specification

Description

Data format

8-bit parallel, IEEE-1284 compatibility mode

Synchronization

STROBE pulse

Handshake timing

BUSY and ACKNLG signals

Signal level

TTL compatible

Connector

57-30360 Amphenol connector or equivalent

Reverse channel

Specifications

Specification

Description

Transmission mode

IEEE-1284 Nibble mode

Adaptable connector

57-30360 Amphenol connector or equivalent

Synchronization

Refer to the IEEE-1284 specification

Handshaking

Refer to the IEEE-1284 specification

Signal level

IEEE-1284 Level 1 device

Data transmission
timing

Refer to the IEEE-1284 specification
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Serial interface

USB interface

Specifications

Specification

Description

Standard

Based on RS-423

Synchronization

Synchronous

Bit rate

Approximately 1.8M bps

Handshaking

X-ON/X-OFF and DTR protocol

Word format

Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector

8-pin mini-DIN

Recommended
cable

Apple System Peripheral-8 cable (preferably
Belkin brand)

Specification

Description

Standard

Based on Universal Serial Bus Specifications
Revision 1.0, Universal Serial Bus Device Class
Definition for Printing Devices Version 1.0

Bit rate

12 Mbps (full speed device)

Data encoding

NRZI

Adaptable
connector

USB Series B

Recommended
cable length

6.5 feet (2 meters)
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Index
A

B

Index

Accessories, 84, 123, 166
Advanced mode, selecting, 34 to 35,
37 to 39
Advanced settings
color, 41 to 49
layout, 60 to 76
orientation, 49 to 53, 56 to 57
paper size, 49 to 59
print quality, 37 to 41
project types, 34 to 37
saving custom, 79 to 81
special effects, 37 to 41
Aligning print heads, 132, 142
Automatic mode, 23, 30
Background printing
Macintosh, 30 to 32, 114 to 118
Windows, 101 to 114
Banding, 141 to 142
Basic printing, 20 to 32
Bitmap files, 66 to 68
Blank pages, 161
Blurry printouts, 144 to 145
Brightness setting, 45

C

Cards, see Photo Quality Ink Jet
Cards
Character sets, international, 167,
176 to 177
Character tables, 167, 176 to 177
Characters, garbled, 158 to 159
Checking printer, 138 to 139
Cleaning print heads, 128 to 130
Cleaning printer, 133
Cleaning sheets, 85
Collate setting, 52, 59
Color Adjustment modes, 44 to 45
Color problems, 142 to 143
Color settings, customizing, 41 to 49
ColorSync, using, 36, 47 to 49
Configuration options, Macintosh,
120 to 121
Contrast setting, 45
Control code, 167
Control panel default settings, 176
Control panel, using, 129 to 130,
137 to 138, 176
Cool Peel Iron-On Transfer Paper
choosing, 83 to 84
loading, 85, 94
specifications, 169 to 171
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Custom settings
color, 41 to 49
deleting, 81
layout, 60 to 76
orientation, 49 to 53, 56 to 57
paper size, 49 to 59
print quality, 37 to 41
project types, 34 to 37
redefining, 80 to 81
saving, 79 to 81
special effects, 37 to 41
Cyan setting, 45

D

E

Index

Default control panel settings, 176
Default printer options, setting,
24 to 25
Despooler, 27, 111
Diagnosing problems, 136 to 140
Diffusion, error, 40
Digital Camera setting, 36, 42 to 43
Dithering, 40
DMA transfers, 99, 153
DOS support, 20, 175
Economy setting, 36, 39
Electrical specifications, 174
Energy Star, 16

Envelopes
loading, 88
specifications, 169 to 171
Environmental specifications, 174
EPSON
Accessories, 84, 123, 166
help, 165 to 166
media, 82 to 94
printer port, 98 to 99, 147, 158
EPSON Spool Manager, see Spool
Manager
Error Diffusion setting, 40
Error notification, 106 to 109,
120 to 121
ESC/P 2 control code, 167

F

G

Faint printouts, 144
Film, see Photo Quality glossy media
Finest Detail setting, 41
Fit to Page setting, 64, 70 to 72
Flip Horizontal setting, 41, 94, 159
Fonts, 167 to 168, 176
Forms, loading, 86
Garbled characters, 158 to 159
Glossy media, see Photo Quality
glossy media
Graph setting, 36, 43
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H

I

Index

Halftoning setting, 40, 142
Head Cleaning utility, 128 to 129
Help, 165 to 166
High Speed copies, 98, 120 to 121
High Speed setting, 40, 140, 142
Horizontal banding, 141
ICM (Image Color Matching) setting,
36, 46 to 47
Ink
cartridge specifications, 172
monitoring level, 109, 118 to 119
replacing cartridges, 123 to 127
replacing outdated cartridge, 127
setting, 23, 30, 35, 39, 142
smears, 88
specifications, 172
Ink Jet Cards, see Photo Quality Ink
Jet Cards
Ink Jet Paper
choosing, 22, 29, 83 to 84
loading, 85
specifications, 168 to 171
Ink Jet Transparencies, see
Transparencies
Interface specifications, 178 to 179
International character sets, 167,
176 to 177
Introduction, 9 to 19

J
L

M

Jammed paper, 137, 157
Job Status window, 109 to 110
Landscape setting, 52, 57
Layout
icon, 30, 59, 71
options, setting, 60 to 76
problems, 159 to 160
tab, 23, 63
Letterhead, loading, 86
Lights, using, 137 to 138
Macintosh
background printing, 30 to 32
ColorSync, 47 to 49
configuration options, 120 to 121
increasing memory allocation,
115
managing print jobs, 115 to 118,
120 to 121
Monitor3, 114 to 118
previewing, 31, 77 to 78
printing from, 28 to 32
problems printing, 150 to 155
Status Monitor, 118 to 119
system requirements, 12 to 13
uninstalling software, 163
Magenta setting, 45
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Main tab, 22
Maintaining printer, 122 to 133
Manuals, how to use, 15 to 16
Margin
problems, 160
with multiple sheets, 86
Mechanical specifications, 173
Media Type setting, 22 to 23,
29 to 30, 35, 39, 83 to 84, 140
Memory allocation, increasing on
Macintosh, 115
MicroWeave setting, 40, 141
Monitor3, 114 to 118
Monitoring
ink level, 109, 118 to 119
preferences, Windows,
102 to 104
print jobs, see Background
monitoring
More Settings dialog box, 37 to 47
Moving printer, 134
Multiple print layouts, 65 to 66,
73 to 74

N
O

Index

Nozzle Check, 131
Orientation options, 49 to 53,
56 to 57
Outdated ink cartridge, 127

P

Packing printer, 134
Page frames, 65 to 66, 73 to 74
Page Order options, 65, 73
Page Setup dialog box, 28, 56
Panoramic Photo Paper, see Photo
Paper
Paper
choosing, 83 to 84
handling problems, 155 to 157
loading, 85 to 94
specifications, 168 to 171
Paper jams, 137, 157
Paper Size options, 49 to 59
Paper support, 86, 89
Paper tab, 23, 50
Paper thickness lever, 88, 91, 92,
142, 144
Parallel interface specifications, 178
Photo Paper
choosing, 22, 29, 83 to 84
loading, 85, 89 to 91
specifications, 169 to 171
Photo Quality glossy media
choosing, 22, 29, 83 to 84
loading, 85 to 87
specifications, 168 to 171
Photo Quality Ink Jet Cards
choosing, 83 to 84
loading, 85, 92
specifications, 169 to 171
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Photo Quality Ink Jet Paper
choosing, 22, 29, 83 to 84
loading, 85
specifications, 168 to 171
Photo Quality Self Adhesive Sheets
choosing, 83 to 84
loading, 85, 93
specifications, 169 to 171
Photo Stickers
choosing, 83 to 84
loading, 85, 93
specifications, 169
PhotoEnhance setting, 35, 41 to 43
PICT files, 74 to 75
Plain paper, 22, 29, 168 to 171
Portrait setting, 52, 57
Preprinted forms, loading, 86
Previewing, Macintosh, 31, 77 to 78
Print dialog box, 21
Print Head Alignment utility, 132, 142
Print heads, cleaning, see Cleaning
print heads
Print jobs
managing in Windows, 96 to 114
managing on Macintosh,
114 to 118, 120 to 121
Print layouts, multiple, 65 to 66,
73 to 74
Print Order options, 59 to 60
Print quality
customizing, 37 to 41
problems, 140 to 145

Index

Print time, setting, 31 to 32,
117 to 118
Printable area
setting, 52, 57, 87, 141
specifications, 171
Printer check, 138 to 139
Printer ID, checking, 139 to 140
Printer parts, 14
Printer port, EPSON, 98 to 99, 147,
158
Printer software
problems, 150 to 155
settings, see Settings, printer
software
uninstalling, 162 to 164
Problems
diagnosing, 136 to 140
paper handling, 155 to 157
print quality, 140 to 145
printer software, 150 to 155
printing, 146 to 149
solving, 135 to 164
unexpected printout results,
158 to 161
uninstalling software, 162 to 164
Progress Meter
dialog box, 26
Speed & Progress options,
97 to 99
Project types, custom, 34 to 37
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Q
R

S

Index

Quality/Speed slider, 23, 30
ReadMe files, 136
Reduce/Enlarge setting, 51, 61 to 64
Rendering Intent setting, 49
Replacing ink cartridges, 123 to 127
Resolution, see Print quality
Reverse Order setting, 52, 60
Rotate by 180° setting, 52, 57
Safety approvals, 175
Safety instructions, 17 to 19
Saturation setting, 45
Self Adhesive Sheets, see Photo
Quality Self Adhesive Sheets
Serial interface specifications, 179
Service, 165 to 166
Settings, printer software
advanced, see Advanced settings
basic, 21 to 24, 28 to 32
default, 24 to 25
reusing on Macintosh, 28
Sharpness setting, 43
Smears, 88, 144 to 145
Special effects, 37 to 41

Specifications
character tables, 167, 176 to 177
control panel settings, 176
DOS support, 175
electrical, 174
environmental, 174
ink cartridges, 172
interface, 178 to 179
mechanical, 173
paper, 168 to 171
printing, 167 to 168
safety approvals, 175
Speed & Progress options, 26,
97 to 99
Spool directory, changing default,
113 to 114
Spool folders, 98, 120 to 121
Spool Manager
problems, 147, 151, 158
using with Windows 3.1,
111 to 114
using with Windows 95 and 98,
100 to 101
sRGB (Standard Red Green Blue)
setting, 36, 46 to 47
Stalled print jobs, deleting, 101, 110,
113
Status Alert dialog box, 103 to 104
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Status Monitor
Macintosh, 118 to 119
problems, 136, 152
uninstalling, 162
Windows, 26, 101 to 110
Support, 165 to 166
System requirements, 10 to 13

T

U

V
Index

W

Technical specifications, 167 to 179
Text/Graph setting, 36, 43
Thickness lever, 88, 91, 92, 142, 144
Tone setting, 43
Transparencies
choosing, 22, 29, 83 to 84
loading, 85 to 87
specifications, 168 to 171
Transporting printer, 134
Troubleshooting, 135 to 166
USB interface specifications,
11 to 13, 179
User Defined paper size, 53 to 55,
58 to 59
Utility
dialog box, 97, 118
icon, 128, 130, 132
tab, 128, 130, 132

Y

Watermarks, 66 to 69, 74 to 76
Windows
default options, setting, 24 to 25
managing print jobs, 96 to 114
printing from, 20 to 25
problems printing, 150 to 155
system requirements, 10 to 11
uninstalling software, 162 to 163
Windows 3.1
default options, setting, 25
managing print jobs, 111 to 114
printer status, checking, 27
uninstalling software, 163
Windows 95 and 98
default options, setting, 24
managing print jobs, 96 to 110
printer status, checking, 26
Status Monitor 2, 26
uninstalling software, 162
Windows NT
default options, setting, 24
managing print jobs, 26, 96 to 99,
101 to 110
Status Monitor 2, 26, 101 to 110
uninstalling software, 162
Year 2000, 17
Yellow setting, 45

Vertical banding, 142
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